Company information

| Mailing address     | Uni hedron  
|---------------------|-------------
|                     | 4 Lawrence Avenue  
|                     | Grimsby, Ontario L3M 2L9  
|                     | Canada  
| Telephone           | (905) 945-1197  
| Website             | uni hedron.com  

© Copyright 2005 - 2023  
Version: 20230524
### Contents

**List of Figures**  
................................................................. 5

**List of Tables**  
............................................................. 7

1 **Introduction**  
1.1 QuickStart  
1.1.1 Setting up the instrument  
1.1.2 Other software  
1.1.3 FITS integration  
................................................................. 9

2 **Measurements**  
2.1 Getting accurate readings  
2.1.1 Seeing conditions  
2.1.2 Light pollution  
2.1.3 Other luminance scales  
................................................................. 11

3 **Theory of operation**  
3.1 Light measurement  
3.2 Communication to the PC  
................................................................. 15

4 **Specifications**  
................................................................. 17

5 **Hardware connections**  
5.1 Hardware connections  
5.1.1 Hub/switch connection  
5.1.2 Wireless connection (wireless client bridge)  
5.1.3 More than one SQM-LE  
5.1.4 Direct connection  
5.1.5 Power over Ethernet (PoE)  
5.1.6 Lock switch  
................................................................. 18

6 **Software development**  
6.1 Writing your own software interface  
6.2 Pascal  
6.3 Custom web page  
................................................................. 23

7 **UniHedron Device Manager**  
7.1 Getting UDM  
7.2 Installation  
7.2.1 System requirements  
7.2.2 Windows  
7.2.3 Mac  
7.2.4 Linux  
7.3 Operation  
7.3.1 Start up  
................................................................. 25
8 Commands and responses .......................................................... 61
8.1 Commands ........................................................................ 61
8.2 Response details ............................................................... 62
8.2.1 Reading request .......................................................... 62
8.2.2 Unaveraged reading request ......................................... 62
8.2.3 Linear reading request .................................................. 63
8.2.4 Inline linear reading request ........................................ 64
8.2.5 Unit information .......................................................... 65
8.3 Calibration commands ...................................................... 66
8.3.1 Calibration information request ..................................... 66
8.3.2 Light calibration command ........................................... 66
8.3.3 Dark calibration command ............................................ 67
8.3.4 Disarm calibration command ......................................... 67
8.3.5 Manually set light calibration offset ............................... 68
8.3.6 Manually set light calibration temperature .................... 68
8.3.7 Manually set dark calibration time period ....................... 69
8.3.8 Manually set dark calibration temperature ..................... 69
8.4 Lock settings .................................................................... 71
8.5 Snow LED accessory ....................................................... 71
8.6 Accessories commands .................................................... 73
8.6.1 Humidity / Temperature sensor ................................... 73
8.6.2 Display accessory ....................................................... 74
8.6.3 LED accessory .......................................................... 75
8.6.4 Relay accessory .......................................................... 76
8.7 Continuous reporting commands ....................................... 77
8.8 Setting Interval reporting parameters ................................................................. 79
  8.8.1 Firewall settings at the listener side .............................................................. 80
  8.8.2 XPort settings for interval reporting mode ..................................................... 80
  8.8.3 Interval reporting period setting ................................................................. 81
  8.8.4 Threshold setting for interval reporting ......................................................... 81
  8.8.5 Interval setting response .............................................................................. 81
8.9 Simulation commands ....................................................................................... 82

9 Installation ............................................................................................................. 84
  9.1 Electrical connection ......................................................................................... 84
  9.2 Mechanical installation ..................................................................................... 84
    9.2.1 Cover selection ......................................................................................... 84
    9.2.2 Cover calibration ...................................................................................... 84
    9.2.3 Cover maintenance .................................................................................... 85

10 Default settings .................................................................................................. 86
  10.1 XPort settings ................................................................................................. 86
  10.2 ARP method .................................................................................................... 86
    10.2.1 For Linux ................................................................................................. 87

11 Firmware upgrade .............................................................................................. 88
  11.1 Details ............................................................................................................. 88

12 Calibration .......................................................................................................... 89
  12.1 Recalibration ................................................................................................. 89
  12.2 Light calibration ............................................................................................. 89
  12.3 Dark calibration ............................................................................................. 89
  12.4 Confirmation .................................................................................................. 89

13 Troubleshooting .................................................................................................. 90

14 Glossary ............................................................................................................. 94

15 Bibliography ....................................................................................................... 95

List of Figures

2.1 Mpsas interpretive scale .................................................................................. 11
2.2 Mpsas vs NELM .............................................................................................. 14
3.1 SQM-LE Block diagram .................................................................................. 15
5.1 Connection diagram ...................................................................................... 18
5.2 Hub/switch connection ................................................................................... 19
5.3 Wireless client bridge connection ................................................................... 19
5.4 Port forwarding example ................................................................................ 20
5.5 Direct connection with crossover cable ......................................................... 21
5.6 PoE wiring example ....................................................................................... 22
5.7 Lock setting ..................................................................................................... 22
<table>
<thead>
<tr>
<th>Section</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.1</td>
<td>Splash screen</td>
</tr>
<tr>
<td>7.2</td>
<td>File menu</td>
</tr>
<tr>
<td>7.3</td>
<td>File Open dialog</td>
</tr>
<tr>
<td>7.4</td>
<td>View menu</td>
</tr>
<tr>
<td>7.5</td>
<td>View: Log</td>
</tr>
<tr>
<td>7.6</td>
<td>View:Directories</td>
</tr>
<tr>
<td>7.7</td>
<td>Data logging header</td>
</tr>
<tr>
<td>7.8</td>
<td>Set Location dialog</td>
</tr>
<tr>
<td>7.9</td>
<td>Plotter window</td>
</tr>
<tr>
<td>7.10</td>
<td>Tool: old log to dat</td>
</tr>
<tr>
<td>7.11</td>
<td>Tool: dat to Moon csv</td>
</tr>
<tr>
<td>7.12</td>
<td>Tool: Comm terminal</td>
</tr>
<tr>
<td>7.13</td>
<td>Tool: dat to .kml</td>
</tr>
<tr>
<td>7.14</td>
<td>Tool: dat to .kml GoogleEarth result</td>
</tr>
<tr>
<td>7.15</td>
<td>Tool: .dat time correction</td>
</tr>
<tr>
<td>7.16</td>
<td>Tool: .dat local time reconstruction</td>
</tr>
<tr>
<td>7.17</td>
<td>RSE algorithm</td>
</tr>
<tr>
<td>7.18</td>
<td>Help menu</td>
</tr>
<tr>
<td>7.19</td>
<td>Help: About</td>
</tr>
<tr>
<td>7.20</td>
<td>Found device (single)</td>
</tr>
<tr>
<td>7.21</td>
<td>Found device (multiple)</td>
</tr>
<tr>
<td>7.22</td>
<td>USB connection details</td>
</tr>
<tr>
<td>7.23</td>
<td>Ethernet connection details</td>
</tr>
<tr>
<td>7.24</td>
<td>RS232 connection details</td>
</tr>
<tr>
<td>7.25</td>
<td>Information tab</td>
</tr>
<tr>
<td>7.26</td>
<td>Log Continuously screen</td>
</tr>
<tr>
<td>7.27</td>
<td>Log Continuously Trigger tab</td>
</tr>
<tr>
<td>7.28</td>
<td>Log Continuously Look tab</td>
</tr>
<tr>
<td>7.29</td>
<td>Log Continuously Status tab</td>
</tr>
<tr>
<td>7.30</td>
<td>Log Continuously Threshold</td>
</tr>
<tr>
<td>7.31</td>
<td>Log Continuously alerts</td>
</tr>
<tr>
<td>7.32</td>
<td>Log Continuously Alarm for darkness</td>
</tr>
<tr>
<td>7.33</td>
<td>Log Continuously Transfer tab</td>
</tr>
<tr>
<td>7.34</td>
<td>Log Continuously Annotation tab</td>
</tr>
<tr>
<td>7.35</td>
<td>Log Continuously GPS tab</td>
</tr>
<tr>
<td>7.36</td>
<td>Calibration tab (initial)</td>
</tr>
<tr>
<td>7.37</td>
<td>Calibration tab (populated)</td>
</tr>
<tr>
<td>7.38</td>
<td>Report interval tab</td>
</tr>
<tr>
<td>7.39</td>
<td>Firmware tab</td>
</tr>
<tr>
<td>7.40</td>
<td>Firmware selection</td>
</tr>
<tr>
<td>7.41</td>
<td>Configuration tab</td>
</tr>
<tr>
<td>7.42</td>
<td>Light calibration confirmation</td>
</tr>
<tr>
<td>7.43</td>
<td>Dark calibration confirmation</td>
</tr>
<tr>
<td>7.44</td>
<td>Sensor arrangement</td>
</tr>
<tr>
<td>7.45</td>
<td>Lock switch settings</td>
</tr>
<tr>
<td>7.46</td>
<td>Fig:Simulation tab</td>
</tr>
<tr>
<td>7.47</td>
<td>Accessories tab</td>
</tr>
<tr>
<td>9.1</td>
<td>Housing</td>
</tr>
<tr>
<td>9.2</td>
<td>Example cover calibration</td>
</tr>
</tbody>
</table>
List of Tables

2.1 Apparent Magnitudes of Known Celestial Objects adapted from [2] ........................................... 11
7.2 .dat to Sun-Moon-MW-Clouds values ................................................................. 38
7.3 simin.csv field description .............................................................................. 57
7.4 Log continuous command line parameters ................................................... 59
7.5 Select device command line parameters ..................................................... 59
7.6 Select features command line parameters .................................................... 59
8.1 Summary of standard commands ................................................................. 61
8.2 Reading request response ........................................................................... 62
8.3 Unaveraged reading request response .......................................................... 63
8.4 Linear reading request response .................................................................. 63
8.5 Inline linear reading request response ........................................................... 64
8.6 Unit information request response ............................................................... 65
8.7 Calibration information request response .................................................... 66
8.8 Light calibration response ............................................................................ 66
8.9 Dark calibration response ............................................................................. 67
8.10 Disarm calibration response .......................................................................... 68
8.11 Response for manual setting of light calibration offset .............................. 68
8.12 Response for manually setting of light calibration temperature .................. 69
8.13 Response of manually setting dark calibration time period ......................... 69
8.14 Response for manually setting of dark calibration temperature .................... 70
8.15 Lock setting command summary ................................................................ 71
8.16 Lock setting response summary .................................................................. 71
8.17 Snow LED accessory command summary .................................................... 72
8.18 Snow LED accessory response summary ..................................................... 72
8.19 Humidity/temperature command summary .............................................. 73
8.20 Humidity/temperature response summary .................................................. 73
8.21 Display accessory command summary ........................................................ 74
8.22 Display accessory response summary .......................................................... 74
8.23 LED accessory command summary .............................................................. 75
8.24 LED accessory response summary ............................................................... 75
8.25 Relay accessory command summary ............................................................ 76
8.26 Relay accessory response summary .............................................................. 76
8.27 Summary of standard commands ................................................................. 77
8.28 Continuous reporting command summary .................................................. 77
8.29 Response of all continuous reporting requests .......................................... 77
8.30 Interval report ............................................................................................... 79
8.31 XPort settings for interval reporting mode .................................................... 80
8.32 Response of viewing or setting interval reporting parameters .................... 81
8.33 Response of request for internal simulation values ...................................... 82
8.34 Request simulation (S....x) ............................................................................ 82
8.35 Response of setting simulation values (S...x) ............................................... 83
10.1 Default XPort settings

13.1 Reading seem too bright
13.2 Reading is 0.00 mpsas
13.3 Cannot Find UDM software
13.4 Meter seems too hot
13.5 Readings do not get dark enough
13.6 Error 404 when trying to reconfigure Ethernet module
13.7 Meter will not respond
13.8 Socket error 10051
13.9 Ping but no readings
13.10 Ping but cannot be found by UDM
13.11 Lantronix Device Installer update problems
13.12 Reading errors reported
13.13 Darkroom-bag readings incorrect

14.1 Glossary of terms

List of Equations

2.1 MPSAS to cd/m²
2.2 NELM to MPSAS
2.3 MPSAS to NELM
8.1 Raw Temperature to degC
8.2 degC to Raw Temperature
1 Introduction

Thank you for purchasing the SQM-LE. You will soon be on your way to collecting scientific data. The SQM series of products have been used in the following applications:

- Quantitatively comparing the sky brightness at different astronomical observing sites.
- Documenting the evolution of light pollution.
- Setting planetarium dome illumination to mimic the skies that people are likely to experience elsewhere in the city.
- Monitoring sky brightness through the night, night-to-night, and year-to-year for astronomical observation records.
- Determining which nights show the greatest promise for finding the 'faintest fuzzies'.
- Calibrating the effect of sky brightness on qualitative measures such as the Bortle Scale or NELM.
- Investigating how sky brightness correlates with the solar cycle and month-to-month sunspot activity.
- Helping to provide local ground truth for future sky brightness prediction with the Clear Sky Clock.
- Helping CCD users make a correlation between the SQM reading and when the background reaches some ADC level.
- Assisting Sea Turtle researchers in studying the amounts of light in areas where turtle hatchlings are affected by artificial lights.
- Researching bird-song synchronization with dawn.
- Researching twilight brightness changes with the addition of external Neutral Density filters. Unihedron offers adapters to attach such filters onto the meter.

1.1 QuickStart

1.1.1 Setting up the instrument

1. Either connect the SQM-LE meter to your network router with the supplied blue straight-through Ethernet cable, or directly to your computer with the supplied red crossover cable.
2. Connect to power supply to the SQM-LE and the AC supply.
3. Launch UDM (Unihedron Device Manager software).
4. Click the “Find” button to find attached devices, then click on the SQM-LE that you connected.
5. Click on “Reading” to get a reading from the SQM-LE.

1.1.2 Other software

- If you are using Windows, you may want to use Knightware SQM-Reader from www.knightware.biz/sqm.
- The CD contains examples of software (Perl, Python, etc.) for various functions that connect to the meter.

1.1.3 FITS integration

Some programs (listed below) gather information from the Unihedron Sky Quality meter products and insert that data into the Flexible Image Transport System (FITS) header.

- MaxPilote (Freeware) incorporates SQM readings from an SQM-LE/SQM-LU into the FITS header while at the same time provide constant readings in a live and updated Data Window.
1 Introduction

- CCDAutoPilot
- FITS4Win2 uses the MPSAS keyword for sorting and filtering image files.
2 Measurements

The SQM-LE provides readings in Magnitudes per square arcsecond, abbreviated as: mpsas, and written mathematically as $\text{mag}_{\text{arcsec}^2}$. Mpsas is a logarithmic measurement which means that large changes in sky brightness correspond to relatively small numerical changes. A difference of 5 magnitudes is a factor of 100 times the intensity. Therefore a sky brightness $5.0\text{mag}_{\text{arcsec}^2}$ darker corresponds to a reduction in photon arrival rate of a factor of 100.

The following schematic gives a rough idea of how to interpret the readings of the SQM:

![Figure 2.1: Mpsas interpretive scale](image)

**Magnitudes** are an astronomical unit of measure for object brightness. Brighter objects have a lower magnitude and darker objects have a higher magnitude value. For example; a star that is 6th magnitude is brighter than a star that is 11th magnitude.

The star Vega is used as the reference point of $\approx 0$ magnitude. Table 2.1 shows the apparent magnitude of some common known celestial objects.

<table>
<thead>
<tr>
<th>App. Mag.</th>
<th>Celestial Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>$-26.73$</td>
<td>Sun</td>
</tr>
<tr>
<td>$-12.6$</td>
<td>full Moon</td>
</tr>
<tr>
<td>$-4.7$</td>
<td>Maximum brightness of Venus</td>
</tr>
<tr>
<td>$+0.03$</td>
<td>Vega, the original zero point</td>
</tr>
<tr>
<td>$+6$</td>
<td>Faintest stars observable with naked eye</td>
</tr>
<tr>
<td>$+27$</td>
<td>Faintest objects observable in visible light with 8m ground-based telescopes</td>
</tr>
<tr>
<td>$+30$</td>
<td>Faintest objects observable in visible light with Hubble Space Telescope</td>
</tr>
</tbody>
</table>

**Arcsecond** is the definition of an arc being divided up into seconds as follows.

1. There are 360 degrees in a circle.
2. There are 60 arcminutes in a degree, and 21600 arcminutes in a circle.
3. There are 60 arcseconds in an arcminute, and 1296000 arcseconds in a circle.
2 Measurements

Square arcsecond \((\text{arcsec}^2)\) is the area covered by a square measuring \(1\text{arcsec} \times 1\text{arcsec}\).

Magnitude per square arcsecond is the definition of brightness in magnitudes spread out over one square arcsecond of the sky. For example; if the SQM provides a reading of 20.00 mpsas, that would be like saying that a light of a 20th magnitude star brightness was spread over one square arcsecond of the sky.

The "magnitudes per square arcsecond" numbers are commonly used in astronomy to measure sky brightness. More details can be found at www.stjarnhimlen.se/comp/radfaq.html

Each magnitude lower (numerically) means just over 2.5 times as much more light is coming from a given patch of sky. A change of 5 mags/sq arcsec means the sky is 100x brighter.

The darkest we've personally experienced with the SQM in a natural clear sky was 21.80.

2.1 Getting accurate readings

Various factors will cause the night sky brightness to fluctuate. Taking more readings will be useful in ruling out spurious events. The SQM gathers light for at least a one second period, and the brightness report is based on the light that was accumulated during that time.

At the darkest sites, natural variations in conditions such as airglow and the brightness of the zodiacal light are limiting factors.

Prevent artificially high (dark) readings by ensuring that there is nothing blocking the view of the sensor. Avoid taking readings near trees or buildings that may block the sensor.

A reading of greater than 22.0 is unlikely to be recorded, however there are reasons for extra dark readings:

- Cloud or ash covered sky in a remote area where little natural sky brightness can be recorded.
- Uncorrected readings from covered meter like a weatherproof housing.
- Obstructed view like inside a forest, or where large buildings are located within the field of view, or a person or bird blocking the view.

When the sky is very dark, the meter takes longer to gather enough light to produce a reading. During this time of light gathering, the reading will remain constant until the meter can start gathering readings fast enough for new reading-requests.

The readings are averaged in an 8-cell rolling buffer, so it may take a while for the meter to produce a new value of darkness when obstructions leave the field of view.

Prevent artificially low (bright) readings by ensuring that there are no lighted objects (street lamps, the moon, etc.) that shine into the sensor at any angle.

2.1.1 Seeing conditions

Scintillation is due to refractive changes in the atmosphere caused by temperature changes at differing heights.

Stars are too small in comparison to the entire SQM field of view, so scintillation is not expected to alter the SQM reading significantly.

2.1.2 Light pollution

Undesirable artificial light that reaches you is considered to be light pollution. Much of this light comes from outdoor illumination of parking lots, street lamps, office buildings, advertising signs, etc..

Other causes of extra light in the night sky are listed below:
2.1 Getting accurate readings

**Aurora**

Charged particles emitted from the Sun are directed to the poles of the earth by the Earth’s magnetic field. These particles collide with atoms in the atmosphere and cause light to be emitted. Aiming the meter at the polar regions during Aurora Borealis (in the North) or Aurora Australis (in the South) will reduce the reading (lighter). Aiming the meter towards the equator will increase the reading (darker) under these conditions.

**Airglow**

Airglow is light produced by various phenomenon in the atmosphere which prevent the sky from being totally dark. Effects of the magnetic poles of the Earth may cause airglow to be brighter near the poles.

**The Milky Way**

As one goes to sites with darker surface brightnesses, the fraction of the total light received by the SQM-LE which can be attributed to the Milky Way bulge increases and so the “offset” in mpsas will be larger (due to the Milky Way.)

The northern view of the Milky Way contributes about 0.10 mpsas under 21.5 mpsas (moonless) skies.

The southern view of the Milky Way might be as big an effect as 0.56 mpsas in dark skies where it goes near-overhead.

For more information, see Surface Photometries of the Milky Way (Schlosser+ 1997)
vizier.u-strasbg.fr/ftp/cats/VII/199/ReadMe

**Moisture**

Clouds, fog, and mist will reflect artificial light back down to the Earth causing a brighter (lower) reading. If there is no artificial light, then clouds may prevent starlight from coming to you and the reading will be darker (higher). This extra-dark situation can occur in very isolated areas like mountain tops, the ocean, or the desert. You will have to be aware of this special situation when analyzing readings.

**Volcanic eruptions**

Dust released into the atmosphere by volcanoes can reflect light from the surface of the earth back down. In a dark location this dust will prevent the light from stars and Milky Way and produce a darker (higher) reading.

**Zodiacal light**

The sunlight reflected of off dust particles in the ecliptic plane of our solar system is called zodiacal light.

The amount of light will be different depending on whether the meter is pointed to the poles or plane of the solar system. It is likely to have less than 2% effect. The primary reason for this small effect is that the brightest and widest part of the zodiacal light is nearest the horizon where the SQM has almost no sensitivity (due to it being a primarily zenith-looking device). The portions at higher altitude are the narrowest and faintest and they would barely creep into the sensitivity cone of the SQM.

2.1.3 Other luminance scales

**Candela per square meter** (cd/m$^2$) is commonly used by lighting engineers.

To convert the SQM mpsas reading to cd/m$^2$, use Equation (2.1):

$$ [cd/m^2] = 10.8 \times 10^4 \times 10^{(-0.4 \times [mag/arcsec^2])} $$

**Naked eye limiting magnitude** (NELM)

Quite often astronomers will refer to a sky by the darkest star they can see, for example a “6th magnitude sky”, in that case you can see 6th magnitude stars and nothing dimmer like 7th magnitude stars. The term “6th magnitude skies” is very subjective to a persons ability to see in the night, for example an older person might say “5th magnitude skies” but a young child with better night vision might say “7th magnitude skies”.
Nobody has performed the task of defining a relationship between the two methods of sky brightness (x magnitude skies and magnitudes per square arcsecond) -- probably because one is subjective and the other is objective and a wide variety of people would have to be polled.

An approximation exists for the conversion between NELM and MPSAS. You can use an NELM converter created by SQM user K. Fisher to do that conversion, or the chart shown in Figure 2.2 and Equations (2.2) and (2.3).

![Figure 2.2: Mpsas vs NELM](image)

Convert NELM (V mags) to MPSAS (B) sky brightness [3]

\[
B_{mpsas} = 21.58 - 5 \times \log\left(10^{\left(4.316 - \frac{NELM}{5}\right)} - 1\right)
\]  

(2.2)

Convert MPSAS (B) sky brightness to NELM (V mags) [4]

\[
NELM = 7.93 - 5 \times \log\left(10^{\left(4.316 - \frac{B_{mpsas}}{5}\right)} + 1\right)
\]

(2.3)

**NSU**

Natural Sky Units [1] (NSU) is radiance relative to an assumed natural radiance of 21.6 magSQM/arcsec².

NSU values indicate how much brighter or darker the sky is compared to a typical historic clear night sky. It is defined here as \( \text{NSU} = 10^{0.4\Delta} \) where \( \Delta \) is 21.6 minus the observed value in magSQM/arcsec².
3 Theory of operation

3.1 Light measurement

The SQM-LE measures the darkness of the night sky to provide readings of magnitudes per square arc second through the Ethernet connection.

A light to frequency sensor (TSL237) provides the micro-controller with a signal whose frequency depends on the amount of incoming light. And, readings from the temperature sensor are used to compensate the light sensor readings through the range of operating temperatures.

In bright skies, the sensor produces a high frequency square wave (up to 500kHz). As the sky gets dark, the sensor produces a low frequency. In absolute darkness, the sensor period is very long, and is defined on the calibration sheet as “Dark period” with a 300s timeout.

Measurement of this wide range of frequencies is done by timers and counters inside the microprocessor. It is difficult for a microprocessor to accurately measure the period of high frequency signals, and just as difficult to measure the frequency of extremely low frequency signals. For this reason the microprocessor has two modes of signal measuring:

**Frequency mode**: The frequency mode is for bright readings where the frequency is high. The sensor signal is fed into a counter that is gated at one second intervals to report a frequency measured in Hz.

**Period mode**: The period mode is for dark readings where the frequency is low. The sensor signal gates a high speed internal counter which reports the period measured in µs.

Both Frequency and Period results are available when connected directly to the meter and using the “rx” command.

The SQM-LE computes mpsas by deciding if the period or frequency report should be used and then compensating for temperature. Deciding between period or frequency mode reporting was originally done at a frequency of 354Hz, but by selecting the “Ideal crossover firmware” setting on the “Report interval” page, the switchover will be 679Hz which offers the best resolution at the switchover point.

The SQM-LE holds the updated period and frequency recordings in memory while waiting for an asynchronous user request for a reading. It is possible for the user to see stale readings if the light sensor cannot gather enough light to produce a reading before the user asks for the next report (i.e. using the “rx” command too frequently). Starting at firmware version 58, the SQM-LE can provide a status of the reading that the user has requested by using the “r1x” command which contains a status suffix character of F/P/S whose meaning is:

**F**: fresh FREQUENCY mode reading.

**P**: fresh PERIOD mode reading.

**S**: STALE reading indicates that this reading has not changed since the last reading because there was not enough light gathered to produce a new reading.
3.2 Communication to the PC

Commands sent from a PC through the Ethernet cable to the Ethernet interface are relayed to the micro-controller. The micro-controller responds to commands by sending data strings to the Ethernet interface which are then relayed to the PC.

Readings are gathered asynchronously by the micro-controller. Requests from the PC are buffered and dealt with as time permits.
## 4 Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
</table>
| Ethernet connection         | 10/100 Mbit (One connection at a time)  
Ports: TCP 10001 (changeable) for data transmission, UDP 30718 for identification. |
| Connection timeout          | Programmable, default = 2 minutes.                                                        |
| Physical Size               | 3.6” x 2.6” x 1.1”                                                                       |
| Meter weight                | 90g                                                                                       |
| Power supply weight         | 100g                                                                                      |
| Ethernet cable weight       | 72g                                                                                       |
| Meter precision             | Each SQM-LE is factory-calibrated. The absolute precision of each meter is believed to be ±10% (±0.10 mag/arcsec²). The difference in zero-point between each calibrated meter is typically ±10% (±0.10 mag/arcsec²) |
| Field of View               | The Half Width Half Maximum (HWHM) of the angular sensitivity is ≈ 10°.  
The Full Width Half Maximum (FWHM) is then ≈ 20°. The sensitivity to a point source ≈ 19° off-axis is a factor of 10 lower than on-axis. A point source ≈ 20° and ≈ 40° off-axis would register 3.0 and 5.0 magnitudes fainter, respectively. |
| Power requirement           | 5-6VDC 300mA  
2.1mmI.D., 5.5mmO.D. connector. Center positive, outside ring negative. |
| Operating temperature range | -40°C to 85°C                                                                             |
| Temperature sensor          | Accuracy: ± 2°C maximum at 25°C  
Location: Internal near light sensor, measures internal meter temperature for light sensor value compensation. |
| Temperature update rate     | 4.3 seconds, 256 samples taken at 60Hz then averaged.                                      |
5 Hardware connections

The SQM-LE can be wired directly to a computer with the supplied red crossover Ethernet cable, or it can be wired to a router with the blue straight-through Ethernet cable. An optional Power over Ethernet (PoE) system can be installed to eliminate the requirement to have a power supply located right at the SQM-LE location.

5.1 Hardware connections

The SQM-LE requires two connections; power, data.

The power connection is made with the supplied “AC to 5VDC Adaptor”.

![Connection diagram](image.png)

**Figure 5.1: Connection diagram**

5.1.1 Hub/Switch connection

The Ethernet hub/switch connection as shown in Figure 5.2 is probably the most common method for connecting the SQM-LE into your system. An Ethernet hub/switch is used to connect the SQM-LE to the same subnet as the PC which accesses it.

The SQM-LE can serve one TCP connection at a time. Once a TCP connection is made with the PC software, no other PCs can access that SQM-LE. The TCP connection must be released (or closed) before other PCs can access it.

More than one SQM-LE may be placed on the network, each will have its own IP address.

It is desirable for the SQM-LE to have a fixed IP address so that accessing from the PC is consistent. Assigning the IP addressing to a fixed value can be done by one of the following methods:

- Using a DHCP router capable of fixing IP addresses to MAC addresses. Note: the SQM-LE MAC address can be identified with the Lantronix Device Installer software, it is also printed on the Ethernet interface inside the SQM-LE.


- Telnet into the SQM-LE and follow the Lantronix instructions in the document “Xport User Guide.pdf” provided with the SQM-LE CD in the “/SQM-LE/reference” directory.

- Web page access to the SQM-LEs IP address.
5.1 Hardware connections

5.1.2 Wireless connection (wireless client bridge)

It is possible to communicate with an SQM-LE using a so-called “wireless client bridge”. In this situation, the PC either acts like an access point (if it has this capability) or is connected to one by a regular Ethernet patch cable. The Linksys WRT54GL may be flashed with free, open source firmware from dd-wrt.com and configured either as the wireless access point or the wireless client bridge.
5.1.3 More than one SQM-LE

If more than one SQM-LE is required to be accessed on one subnet from another subnet, your router may be able to be configured for port forwarding to each SQM-LE. Normally port 10001 is used. That default port can be changed using either the Lantronix Device Installer software or by Telnet into port 9999.

On the LAN side, the SQM-LEs can be addressed like so:

<table>
<thead>
<tr>
<th>SQM#</th>
<th>IP Address</th>
<th>Port Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQM#1</td>
<td>192.168.1.132</td>
<td>10001</td>
</tr>
<tr>
<td>SQM#2</td>
<td>192.168.1.133</td>
<td>10001</td>
</tr>
<tr>
<td>SQM#3</td>
<td>192.168.1.134</td>
<td>10001</td>
</tr>
<tr>
<td>SQM#4</td>
<td>192.168.1.135</td>
<td>10001</td>
</tr>
</tbody>
</table>

If the router has a dynamic DNS address of sqmcity.dyndns.org then these same SQM-LEs could be accessed from the Internet in the following way, provided the port forwarding shown in the image was adopted:

<table>
<thead>
<tr>
<th>SQM#</th>
<th>Dynamic DNS</th>
<th>Port Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQM#1</td>
<td>sqmcity.dyndns.org</td>
<td>10001</td>
</tr>
<tr>
<td>SQM#2</td>
<td>sqmcity.dyndns.org</td>
<td>10002</td>
</tr>
<tr>
<td>SQM#3</td>
<td>sqmcity.dyndns.org</td>
<td>10003</td>
</tr>
<tr>
<td>SQM#4</td>
<td>sqmcity.dyndns.org</td>
<td>10004</td>
</tr>
</tbody>
</table>

![DD-WRT CONTROL PANEL](image)

Figure 5.4: Port forwarding example

5.1.4 Direct connection

A direct data connection from the SQM-LE can be made to a PC with the use of an Ethernet crossover cable (included with the Unihedron SQM-LE purchase). See Figure 5.5.
5.1 Hardware connections

The SQM-LE does not come shipped with a fixed IP address, so it may be necessary to fix that address before installing the unit into such a direct connection system without DHCP server software running. First try connecting to the SQM-LE without fixing it address, if that fails then you may have to fix the IP address as follows:

1. Install the unit into a DHCP system where the IP addresses are assigned to connected devices.

2. Determine the SQM-LE IP address by querying the router or using the “Lantronix Device Installer” in Windows. In Linux, you may also use “nmap” to discover connected device IP addresses.

3. Use a browser to go to the SQM-LE IP address as in the following example: http://192.168.1.nnn

4. There is no default username and password, just press OK.

5. The built in Lantronix XPort Device Server Configuration Manager will appear.

6. Select NETWORK from the left side.

7. Select the radiobutton associated with “Use the following IP configuration:”, and enter the IP address that you would like the unit to occupy in your direct connection system. For example:
   
   IP Address: 192.168.1.141 \textit{(assuming that address is free)}
   
   Subnet Mask: 255.255.255.0
   
   The “Default Gateway:" field may be left blank.

8. Press “OK” at the bottom then “Apply Settings” on the menu of the left side of the page and the unit will apply the settings and reboot in about 15 seconds. Since you may have changed the IP address, the web browser will not respond unless you browse to the new address.

9. The unit is now ready for connection into a non-DHCP system or a direct connection system with a crossover cable.

5.1.5 Power over Ethernet (PoE)

You can use the SQM-LE with an optional PoE system to cut down on the power cable wiring in installations that are very far (300ft) away from a power cable.

To test the PoE system:

1. Turn off the computer. This is required because Windows sometimes only performs a new device check on locally connected devices at power up.

2. Wire up the system as shown in figure 5.6:
3. Turn on the computer.

4. Start up the Unihedron Device manager (UDM) software.

### 5.1.6 Lock switch

To prevent undesired alterations to the SQM-LE, the Lock switch should be placed into the "Locked" position.

All versions prevent firmware upgrades and calibration changes with the lock set.
Firmware feature version 42-45 prevent changes to the Report Interval settings with the lock set.
Firmware feature version 46 and above implement optional settings to allow the lock switch to optionally limit access to the Calibration settings, Report interval settings, Configuration settings, and these same optional settings. See the Configuration tab in UDM for these settings.

If you are sure that your network is completely secure, then you can set the lock switch to the unlocked position which allows all remote changes to be made to the SQM-LE.
6 Software development

The SQM-LE uses the Lantronix XPort Ethernet module to communicate as a standard serial port socket. Many programming languages support socket connections to this type of Ethernet connection.

Each SQM-LE has a unique MAC address usually with a prefix of “00-20-4A-…”. This MAC address can be used to distinguish the exact SQM-LE device from other Ethernet devices.

Also, many routers allow for IP assignment based on MAC address.

6.1 Writing your own software interface

All of the commands and responses of the SQM-LE are documented in Section 8.

To communicate with the SQM-LE, the following general steps are required:

1. A TCP connection must be made to the IP address assigned to the SQM-LE. The default TCP port of access is 10001.
2. If you need to find an SQM-LE on the network; the discovery process involves broadcasting (to 255.255.255.255) the hex string 00 00 00 F6 to UDP port 30718. The Lantronix XPort will send a response that starts with hex 00 00 00 F7 (elements 1-4), and elements 25-30 contain the MAC address of the responding unit.
3. Data commands are sent to the SQM-LE, and it responds with a string of characters.
4. Close the socket so that other programs can access the SQM-LE. Note: Only one connection can be made to the SQM-LE at a time. Therefore leaving a connection open constantly prevents other connections from being made.

Various examples of reading from the SQM devices are supplied on the CD and available at the Unihedron website. Below is an example using Perl to read the SQM Ethernet device:

Listing 6.1: Read SQM-LE using Perl

```perl
#!/usr/bin/perl
#Filename: read-sqmle.pl
#Description: Utility to read Unihedron Sky Quality Meter-LE (Ethernet model)

use IO::Socket;

open and configure serial port
$remote = IO::Socket::INET->new(
  PeerAddr => '192.168.1.125',
  PeerPort => 10001,
  Proto => 'tcp');

Send request to SQM
$remote->send("rx");

Get response from SQM
$remote->recv($saw,255);

Close the socket so that other programs can use the SQM
$remote->close;

Print the SQM result to the screen
printf("%s", $saw);
```
The above program prints a result like this:
\[ r, -09.42m, 0000005915Hz, 0000000000c, 0000000.000s, 027.0C \]

### 6.2 Pascal

The UDM program contains many examples of finding the SQM devices and reading data from them. It is open source and written in Lazarus/FreePascal. The source files for UDM are available here:

unihedron.com/projects/darksy/cd/udm/

### 6.3 Custom web page

Details for installing your own web page and Java software can be found at the Lantronix website in their FAQ titled: **Web Enabling Your Serial Device**.
7 Unihedron Device Manager

The Unihedron Device Manager (UDM) program is intended for use in maintaining and testing the Unihedron connected Sky Quality Meter products. Windows, Mac, Linux versions of UDM area available on the supplied CD. It is used to:

- Read version information.
- Request readings.
- Read and set calibration data.
- Read and set all other meter parameters.
- Install new firmware.
- Setup and retrieve data from datalogging meters.
- Continuously log data from connected meters.

7.1 Getting UDM

UDM is supplied on the CD that shipped with the SQM-LE. The latest version of UDM is available at the Unihedron website at this location

www.unihedron.com/projects/darksky/cd/

7.2 Installation

7.2.1 System requirements

The UDM is a fairly simple (but large) program which should run sufficiently on any present-day computer under the Windows, Mac, or Linux operating systems.

The Windows version of UDM can also be run in a virtualization mode using VMware Fusion. Access to the network is achieved by the menu Virtual Machine > Network Adapter > Bridged (Autodetect) being checked.

7.2.2 Windows

The Windows version of UDM is in a setup.exe style file located in the Windows subdirectory of the CD, for example:

\Windows\setup1.0.0.38.exe

Simply double-click on that file to start the installation procedure.

7.2.3 Mac

The Mac OSX version of UDM is a dmg file located in the Mac subdirectory of the CD, for example:

/Mac/udm.app.dmg

Drag the app to the /Applications directory.

7.2.4 Linux

The Linux version of UDM is available in a Debian package separately for both 32bit and 64bit systems located in the Linux directory of the CD, for example:

/Linux/udm_20140821-1_i386.deb

Open the file with package installer program like GDebi.
7.3 Operation

After starting UDM, a list of found devices should appear, if your device is not listed on the screen, try clicking “Find” once more to search for connected devices.

If more than one SQM device is found, then you will have to select (click) on one of the devices, otherwise if only one device is found, then click on “Version” or “Reading” of the information tab for more information.

The tabs can be used to select various functions when working with your selected device. These tabs and their functions are described further in this document.

7.3.1 Start up

After starting the UDM program, a splash screen shown in Figure 7.1 is temporarily shown while the program searches for attached devices.

![Unihedron Device Manager](image)

Figure 7.1: Splash screen

1. UDM searches for attached USB devices first. This step is fairly quick (a few seconds).
2. UDM then searches for attached Ethernet devices within the reach of the Ethernet network but not outside a firewall. This step may take about 30 seconds.

If no devices are found, then the main UDM program will be shown with the “found devices box” empty. You can attach an SQM device to your computer and press the “Find” button to search for the newly connected devices.

If you know that an Ethernet device is connected but it does not show up, then a network problem may be the cause. Also check the power connection to the SQM-LE.

If you know that a USB device is connected but it does not show up, then there may be a device driver issue. Check the USB device listing for your operating system. These USB devices should appear as a COMM port. Also, check the troubleshooting notes in section 13 on page 90 for possible solutions.

7.3.2 Main screen

The main screen of UDM consist of the following sections:
7.3 Operation

1. Window controls
2. Menu
3. Found devices box
4. Selected device details
5. Information section
6. Status bar

7.3.3 Main menu

The main menu of UDM consists of the items; File, View, Tools, Help as defined below.

7.3.4 File menu

The file menu is used for: opening files, finding newly attached devices, and quitting the program as shown in Figure 7.2.

![Figure 7.2: File menu](image)

File : Open

The “File : Open” menu item is used to open up previously stored log files or calibration reports.
7.3.5 View menu

The view menu allows you to enable various tabs and check other settings of the UDM program.
View : Simulation

Click on “View : Simulation” to toggle visibility of the “Simulation” tab. The Simulation tab can be used to send requests to the SQM-LE to simulate conversions of frequency and period to light meter values. See page 56 for more details.

View : Configuration

Click on “View : Configuration” to toggle visibility of the “Configuration” tab. The Configuration tab is used to configure the SQM with its calibration values when calibrated light and dark settings are being performed.

View : Log shows a window of commands and responses sent to and received from the SQM during this session of running UDM. Some excessively repetitive commands are suppressed from this listing.

Figure 7.5: View : Log

View : Directories shows the directory paths used by UDM to store and retrieve data.

Figure 7.6: View:Directories

Logs Directory Path shows the path where logged records are kept. These logged records are created when using the “Log one Record” or “Log Continuously” features. Also, log files from data-logging meters will be stored here from the “Retrieve All” function.

The “Logs Directory Path” path can be changed from its default by pressing the folder button the right. After the path has been changed, new log files will be stored in that new folder.
**TZ database path**  The Time Zone information is required for datalogging purposes because the timestamp is logged as UTC. Since time zones change over the years, the entire Time Zone database is required and hence distributed with UDM and stored at the displayed “TZ database path”. This path is not changeable.

The Time Zone database is taken from: [http://www.twinsun.com/tz/tz-link.htm](http://www.twinsun.com/tz/tz-link.htm)

**Firmware files path**  The firmware for the SQM-LE can be updated or reverted using UDM. These firmware files are stored at the displayed firmware files path. This path is not changeable.

**Data Directory**  is the place where some data files are kept, specifically the change-log for UDM and firmware files. This path is not changeable.

**Configfile path**  is the place where UDM stores its configuration about the program and attached SQM devices. This path is not changeable.

**View : DL Header**  shows the Data-logger header editing page. See the information at www.darksky.org/measurements for a detailed description of each field.

![Figure 7.7: Data logging header](image)
**DL : Position** can be changed by pressing the Edit button which calls up the following dialog:

![Set Location dialog](image)

**Figure 7.8: Set Location dialog**

The “Set location” dialog is used to type in your location and have it verified on the world map. Use the following steps to set the location:

1. Type the exact location coordinates (in degrees) of the SQM-LE into the “Desired” fields.
2. The mouse pointer can be used to select an approximate location if you are not sure of the exact coordinates.
3. The “Elevation” entry is optional as it is not used for anything yet.
4. Press the “Apply” button when you are satisfied with the desired values. Note: The “Apply” button will only be enabled if there is a difference between the desired and actual values.
5. Press “Close” when you are satisfied with the actual values.

The “Local timezone region” and “Local timezone name” are required by UDM to calculate local times of the recorded data before storing to disk. UTC timestamps are stored in the SQM-LE.

The cover offset is a text only field that indicates what offset was used on the calibration data of the SQM-LE.
View : Plotter  The plotter window can be used to analyze .dat files recorded by UDM. An example shown below:

- The left sidebar tab be expanded and contracted by clicking on the tab title bars.
- Many data points can be optionally included from the “Settings” tab.
- The plotter can also display rise/set Twilight lines for the Sun.
- The “Help” tab shows some hints for zooming and also the line color definitions of plotted lines.
- The bare plot can be saved in vector graphics (SVG) or bitmap (PNG) modes using the “Save” buttons in the “Settings tab”.

View : Plotter : Time offset  To assist in correcting timing problems when the datalogger real-time-clock was not properly set, the Time offset feature can be used as follows if there are two datalogger files, one with proper time set, and a second with bad time setting:

- Open the Plotter
- File mode: Multiple
- Settings: Display: Grid, and Darkness only, all other display selections can be unchecked.
- Select Plot number: 1, then click on the reference file (with the correct timing).
- Select Plot number: 2, then click on the problem file.
• Enter a starting **time offset** value.

• Press **Replot**.

• Alter the offset and replot until there is overlap of the two lines at a date and time that should be overlapping.

• Record the time offset and use it in the **Tools: .dat time correction** utility as follows ...

• press "**Select file**", then select the problem .dat file.

• Enter the **time difference** which you recorded earlier.

• Press "**Correct .dat file**".

**View : Plotter : Customized colors and line widths**  
The colors and width of plot lines and can be modified in the udm.ini/cfg file (found in the View:Directories:ConfigFile path). Edit the file with a text editor and place settings under the Plotter: section, for example: MPSASColor=clRed

The following names can be used to define plot line colors: MPSASColor MPSAS2Color MPSAS3Color MoonColor SunColor CivilColor NauticalColor AstronomicalColor SunTwilightColor VoltageColor TemperatureColor

Color names or numbers are defined here: [https://wiki.freepascal.org/Colors#Convert_TColor_to/from_string](https://wiki.freepascal.org/Colors#Convert_TColor_to/from_string)

The width of a line is defined with an integer number of pixels, for example: MPSASWidth=3

The following names can be used to define plot line widths: MPSASWidth MPSAS2Width MPSAS3Width MoonWidth SunWidth CivilWidth NauticalWidth AstronomicalWidth SunTwilightWidth VoltageWidth TemperatureWidth
7.3.6 Tools menu

Tools : old log to dat

The “old log to dat” tool is used to convert the original .log files that UDM created before the .dat file was made standard. Figure 7.10 shows the setup dialog for conversion.

![Figure 7.10: Tool : old log to dat](image)

Tools : dat to Moon csv

The “dat to Moon csv” tool is used to convert .dat files to a csv file that contains Moon data using algorithm library from Andreas Hörstemeier [7]. This tool prepares the file for importation into a spreadsheet like Excel, OpenOffice, or LibreOffice. For importing into a spreadsheet.

The value for “Moon phase angle” reported in the .csv is:

- 180 or -180 = New Moon
- 0 = Full Moon
- Positive numbers Waxing (growing)
- Negative numbers Waning (shrinking)

![Figure 7.11: Tool : dat to Moon csv](image)

Press the “Select ...” button shown in Figure 7.11 to select the file and start the conversion process.

You may also be interested in the “Excel import” instructions listed in section 7.5.1.
Tools: Comm terminal

The “Comm terminal” is a communication terminal window used for sending manual commands and viewing the response of the selected (from the found devices window) device.

![Comm terminal](image)

Figure 7.12: Tool: Comm terminal

Tools: DL retrieve

The “DL retrieve” tool is used for datalogging and Vector model to pull in data files that were stored on disk previously.

Tools: .dat to .kml

Creates a .kml file from a .dat file. This is used when the SQM-LE and an external GPS are read by UDM in the Log Continuous datalogging mode.

![.dat to .kml conversion](image)

Figure 7.13: Tool: .dat to .kml

The .kml file can be imported into GoogleEarth to create an image similar to this:
This tool uses a legend image (km ilegendnewatlas.png.png or km ilegendcleardarksky.png) which must be available to GoogleEarth to properly display the legend. The resultant .kml file and legend file is stored in the “Logs directory path”.

A minimum set of data can be used by UDM to produce a map with only the MSAS brightness, Latitude,Longitude.

The timestamp

The data file (with .dat extension) requires a definition line which contains at least the following fields:

# UTC Date & Time,MSAS,Latitude,Longitude

A minimum example of a data file showing three data records:

```
# UTC Date & Time,MSAS,Latitude,Longitude
2018-02-07T04:27:57.642;19.0;33.2208;-116.3387
2018-02-07T04:28:17.089;18.3;33.2208;-116.3422
2018-02-07T04:28:37.105;18.0;33.2210;-116.3457
```

The UTC Datestamp data is not used to make the .kml file, but UDM requires something there.

The format of the fields are:

# YYYY-MM-DDTHH:mm:ss.fff;mag/sqarcsec;Degrees;Degrees

**Tools : .dat time correction**

Corrects a .dat file for out of synch timing by a manually entered offset. See figure 7.15.

This may be useful when the battery has expired in the datalogging meter, or if the clock was not set at the beginning of the datalogging session.
Press the “Correct .dat file” button to write the corrected file to disk. The location of the new file is shown in the bottom Filename section.

**Tools : .dat reconstruct local time**

If the datalogger timezone was not set properly, this tool can be used to recreate the local time values in the .dat file.

Select the desired .dat file to reconstruct.
Select the proper region and time zone.
Press the “Reconstruct .dat local times” button
The reconstructed file will be written to disk at the location specified in the bottom Filename section.

**Tools : .dat time correction**

If the real-time-clock inside the datalogger was not set properly or the battery was not plugged into the datalogger quickly enough to keep the super-capacitor charged before datalogging began, then there would be a difference in time when the data was retrieved. The .dat file can be corrected with this tool.
**Tools : .dat to Sun-Moon-MW-Clouds .csv**

Reads a .dat file of SQM data and creates a comma separated value (.csv) file with these attributes at each SQM time reading.

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Geographic name of SQM site, taken from &quot;Location name&quot; in raw data file; if blank the Location is printed as &quot;Not-Specified&quot;</td>
</tr>
<tr>
<td>Lat</td>
<td>Latitude of SQM, in fractional degrees, taken from Position value in raw data file; if blank, processing will stop</td>
</tr>
<tr>
<td>Long</td>
<td>Longitude of SQM, in fractional degrees, taken from Position value in raw data file; if blank, processing will stop</td>
</tr>
<tr>
<td>UTC_Date</td>
<td>Universal date extracted from raw data file “UTC Date &amp; Time”</td>
</tr>
<tr>
<td>UTC_Time</td>
<td>Universal time extracted from raw data file “UTC Date &amp; Time”</td>
</tr>
<tr>
<td>Local_Date</td>
<td>Local date extracted from raw data file “Local Date &amp; Time”</td>
</tr>
<tr>
<td>Local_Time</td>
<td>Local time extracted from raw data file “Local Date &amp; Time”</td>
</tr>
<tr>
<td>Celsius</td>
<td>Temperature of SQM, degrees Celsius, extracted from raw data file &quot;Temperature&quot;</td>
</tr>
<tr>
<td>Volts</td>
<td>Voltage of SQM, volts (battery supply), extracted from raw data file &quot;Voltage&quot;</td>
</tr>
<tr>
<td>Msas</td>
<td>SQM reading (Magnitudes per arc second squared)</td>
</tr>
<tr>
<td>Status</td>
<td>SQM record type</td>
</tr>
<tr>
<td>MoonPhase</td>
<td>Phase of the moon in degrees, 0 degrees = Full Moon; + and -180 degrees = New Moon; waxing Moon from +180 to 0 degrees: waning Moon from 0 to -180 degrees; values flip from -180 to +180 at Full Moon</td>
</tr>
<tr>
<td>MoonElev</td>
<td>Elevation angle in degrees of the moon above or below (negative) the local flat horizon</td>
</tr>
<tr>
<td>MoonIllum</td>
<td>Percentage of moon illuminated</td>
</tr>
<tr>
<td>SunElev</td>
<td>Elevation angle of the sun above or below (negative) the local flat horizon</td>
</tr>
<tr>
<td>MinSince3pm</td>
<td>Number of minutes since 3pm of the previous day; allows tracking of time from afternoon, through evening, night and morning; positive number</td>
</tr>
<tr>
<td>Msas_Avg</td>
<td>Average value of SQM reading during the current night, under conditions of sun lower than 18 degrees below the horizon and moon lower than 10 degrees below the horizon</td>
</tr>
<tr>
<td>NightsSince1118</td>
<td>Number of nights since January 1, 2018; useful to track number of nights since that day</td>
</tr>
<tr>
<td>RightAscensionHr</td>
<td>Right ascension in hours of the zenith at the SQM location; equivalent to Local Siderial Time at the SQM location; used to calculate the Galactic orientation</td>
</tr>
<tr>
<td>Galactic_Lat</td>
<td>Angle in degrees between the zenith at the SQM location and the highest point of the Milky Way Arc; value of zero implies the SQM is pointed directly into the Milky Way</td>
</tr>
<tr>
<td>Galactic_Long</td>
<td>Angle in degrees from the Galactic Center (Sagittarius) eastward along the Galactic equator</td>
</tr>
<tr>
<td>J2000days</td>
<td>Days since January 1, 2000; fractional</td>
</tr>
</tbody>
</table>

Table continued on next page ...
Table 7.2 – continued from previous page

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ResidStdErr</td>
<td>Residual Standard Error multiplied x1000; a measure of jaggedness of the SQM data over a time range specified by the user (typically 90 minutes); if RSE is large, for example &gt; 50, then conditions can be considered to have been cloudy.</td>
</tr>
</tbody>
</table>

**ResidStdErr – some details:**

Scattered clouds passing overhead cause variations in the SQM brightness readings - a plot over time under a cloudy sky tends to be very jagged. See Figures 2 and 3 of this report [https://5023ce21-5614-48fc-a5d4-292b92640d50.filesusr.com/ugd/445aec_7522a23976bc472f8d8d8b907d8d5d5b7.pdf](https://5023ce21-5614-48fc-a5d4-292b92640d50.filesusr.com/ugd/445aec_7522a23976bc472f8d8d8b907d8d5d5b7.pdf) by Bill Kowalik, and Michael McKeag, Oregon Chapter of International Dark-Sky Association.

ResidStdErr is a measure of the jaggedness or roughness of the SQM data over time. Large values indicate cloudy conditions. Small values represent clear conditions. You can later filter out cloudy data by only accepting data points characterized by a small RSE value.

This cloud estimation algorithm fits a linear regression to the SQM data over a time range, and calculates the Residual Standard Error (RSE), a measure of the fit between the linear regression and the actual SQM data. See figure below.
We have been using a 90-minute time span as shown in the Figure above. The RSE value is assigned to the point in the middle of the time span. The time window advances one time step (typically 5 minutes in our data files) and the fit is calculated for the new center point, etc.

This algorithm processes one day of data at a time. Assuming a 5-minute sample spacing in time, there are at most 288 samples per day, so arrays are dimensioned to 300; attempts to process SQM data with time spacing that provides more than 300 samples per day will fail.

The Range parameter is the number of samples (usually 5 minutes apart) to include before and after the current point at which the Residual Standard Error of regression calculation is performed; the full width of the interval in terms of number of points to consider in the calculation is \(2 \times \text{Range} + 1\) so that a Range of 6 incorporates a time span of 60 minutes and a Range of 9 evaluates to a 90 minute span.

**Additional Notes:**

1. If the Latitude and Longitude are not specified in the input .dat file, processing will stop.

2. If the Location name is not specified in the input .dat file, the location name will be printed in the output .csv file as “Not-Specified”.

\[
\text{Residual Standard Error} = \sqrt{\frac{\sum_{i=1}^{n} (\text{Observed} - \text{Estimated})^2}{n-2}}
\]
3. A night sequence is considered to begin at 1500 Local Time.

4. The first Range number of points in a day and the final Range number of points in a day are assigned dummy RSE values of 999000.0

5. During daylight hours when the entire Range of values has SQM readings of 0.0, the RSE values is reported as 0.0
7.3.7 Help menu

**Help : Cmdline Info** shows the commands that can be used when starting UDM from the command line.

**Help : Version Info** shows the detailed version information for the UDM software.

**Help : About** displays a simple screen with the version identifier.

---

**Found devices** box shows all the connected SQMs available that UDM can find from this computer. If only one device is found, then UDM auto-selects it and gathers the version information for that selected device.

If more than one device is found, then UDM does not select any of the devices. You may select the desired device by clicking in the found devices box on the SQM that you want to know more about. Once you select the device, then the connection details are displayed. Clicking on the “Version” or “Reading” button will gather more information from the meter.
7.4 Information tab

**Device details** shows the connection details of the selected SQM listed in the “Found devices” box.

The USB “Port” field is editable so you may enter your own port that might not be defined in the found box. See Figure 7.22.

![Figure 7.22: USB connection details](image)

The Ethernet IP and port fields are editable so you may enter your own IP and port that might not be defined in the found box. The default port number for the SQM-LE is 10001. See Figure 7.23.

![Figure 7.23: Ethernet connection details](image)

The RS232 fields are editable so you may enter your own port and baud rate. The baud rate for the SQM-LR is 115200. See Figure 7.24.

![Figure 7.24: RS232 connection details](image)

**7.4 Information tab**

The information tab is used to show information about the version and the reading of the selected SQM.

Press the “Version” button for an updated list of data about the device version, and press the “Reading button” for an updated list of data about the device reading.
Figure 7.25: Information tab

The Header button calls up the data file header entry screen, see the datalogging Header section on page 30 for more information. This header information is used when storing logged data to the disk with the “Log one record” or “Log continuous” functions described below.

**Log one record** gathers one data record from the connected SQM and stores that information to a data log file on the disk in the “Logs directory path”. The location of the file can be identified and changed by “View : Directories”. The log file can be accessed later from the “File : Open” menu.

### 7.5 Log Continuous

The “Log continuous” function allows data from the connected SQM device to be logged repetitively as shown in Figure 7.26.
7.5 Log Continuous

Log Continuous Trigger options must be defined before logging, see Figure 7.27 for possibilities:

1. Select the frequency of logging from the trigger tab.
2. Select if “Moon data” is to be computed and logged.
3. Select “Freshness” to identify Fresh/Stale results. This is useful when recording brightness from a moving platform, specifically.
4. Select “Single .dat file” to prevent separate daily files being created each 24 hours.
5. Select “GoTo accessory” when the meter is mounted on a GoTo tripod and direction commands come from the GoTo tab.
6. Select “Raw frequency” when the rFx command is desired which send the linear raw light reading frequency. (Firmaware 75 and above).
7. Select a limit to the number of records. A value of zero is default and means there is no limit. Any other value 1-1000 means that UDM will stop recording after that many records have been taken.

8. Press the “Record” button. The records are stored in a logfile whose location is shown in the “Logfile name” area. A new logfile is automatically created at the beginning of each day (at local time 0:00).

9. Press the “Stop” button when you want to stop the recording process.

10. Log files can be accessed by the “File : Open” menu selection or by pressing the “folder” button shown in the “Log Continuously” screen.

11. Press “Close” when done with the continuous logging feature.

**Threshold to record** A threshold for recording readings can be set before starting recording. Any reading greater or equal to this threshold value will be recorded in the log file.

![Threshold](image)

Figure 7.30: Log Continuously Threshold

A threshold of 0 will allow all readings to be recorded.

The threshold indicator will turn green if the threshold of the triggered reading is met (recording) and red if the triggered reading is below the threshold (no recording).

The threshold value is saved in the registry configuration file when it is changed. Changes can only be made while not recording.

An override from the command line options (-LCTH,x) can be made. The override will only take effect for the current session and will not alter the saved configuration.

**Audio alerts** In cases where you want to be alerted that a reading will be taken, for example, when manually pointing the meter, the Pre-reading audio alert named `prereading.wav` can be enabled as shown in (Fig. 7.31) to play an audio file two seconds before the light meter record is logged. The “Test” button plays this file for test purposes.

Also, an optional reading alert sound file named `freshreading.wav` can also be played exactly when the reading has been gathered by selecting an option from the reading alert box. By selecting “Fresh only”, the sound is only played when the meter gathers a “Fresh” reading (Fresh readings are defined in the Light measurement section 3.1). By selecting “All”, the sound is played after every light meter reading has been recorded.

![Audio alerts](image)

Figure 7.31: Log Continuously alerts

The audio files are located in the Data Directory (which can be identified from the main page View→Directories).

**Alarm for darkness** When the darkness is over the threshold amount, an audio file can be enabled to play (Fig. 7.32). The Test button plays this file for test purposes. The audio file is named `alarmsound.wav` and is located in the the Data Directory (which can be identified from the main page View→Directories).
7.5 Log Continuous

The .dat file can be sent via FTP, SCP, or SFTP to a server by making settings on the left side of the Transfer tab (shown in Fig. 7.33)

The following transfer protocols files is available:

- **FTP** (File transfer protocol).
- **SCP** (Secure file Copy) transfers require that the `scp` command exists externally from UDM. For Linux and Mac, the `scp` command is `scp` and can be proven to exist with the `which scp` command. In Windows, you may have to install a program called `pscp` and rename it to `scp`.
- **SFTP** (Secure File Transfer Protocol) assumes that the `sftp` command exists.

Files will be sent to the server using one or more of the following options:

- `.dat` sends the date-named .dat file which contains recorded readings.
- `.csv` sends the date-named .cav file which contains recorded readings in comma separated variable format.
- **Plot** sends the daily plot and an html file that can be used to display on a webserver (details below)

When the **Plot** option is selected, UDM fills in the sqm-template.html file in the data directory with reading and date variables, then sends the resulting filled-in information as sqm.html to the server. A date-named plotfile is also sent (its name is defined as startdate.png and encoded inside sqm.html in the imagename variable described below).

The possible variables that you can use in the sqm-template.html are:

- <!-- SQM-location --> The location name taken from the associated header entry.
- <!-- SQM-coordinates --> The GPS coordinates taken from the associated header entry.
- <!-- SQM-timestamp --> The timestamp of the current reading.
- <!-- SQM-nexttimestamp --> The timestamp of the next reading.
- <!-- SQM-mpsas --> The current reading in mpsas.
Each variable must be on its own separate line in the sqm-template.html file, and the variable must start at the beginning of the line. See the sqm-skeleton.html file for an example. If the sqm-template.html does not exist after initial installation, then it is created from a copy of sqm-skeleton.html file located in the initial program installation directory.

**Annotation settings** While the “Log Continuous” mode is recording data, annotations can be made to the log file records with hotkeys. The Annotation tab allows the definition of hotkeys and their associated annotation text that will appear at the end of an annotated record.

**Persistent annotation** The “Persistent” mode makes the annotated text persistently appear at the end of each logged record after the first time the hotkey is pressed.

Without “Persistent” checked, annotation text is only appended to a record when the hotkey is pressed, and other records have no annotation text.

**Synchronized annotation** The “Synchronized” mode postpones annotation requests until the next scheduled record so that the annotated text is synchronized with scheduled triggered recordings.

Without “Synchronized” checked, the hotkey will immediately trigger a record log, and the associated annotation text will be appended to that triggered record.

**GPS** UDM will read the data produced from an externally connected USB or serial GPS receiver like the GlobalSat BU-353 GPS. Also the Bluetooth GPS Dual XGPS160 has been test on a Mac.
The following GPS units have been tested with the latest UDM software:

<table>
<thead>
<tr>
<th>GPS</th>
<th>Connection</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>GlobalSat BU-353</td>
<td>USB</td>
<td>4800 baud</td>
</tr>
<tr>
<td>GlobalSat BU-353 S4 (5Hz)</td>
<td>USB</td>
<td>115200 baud</td>
</tr>
<tr>
<td>Dual XGPS160</td>
<td>Bluetooth</td>
<td>See GPS owners manual</td>
</tr>
</tbody>
</table>

Enter the communications port name (see below) into the Port field, the baud rate into the baud field, then enable the GPS. Once enabled, UDM continuously scans the GPS port for three NMEA words.

**GPS on Windows 10** To get the Communications Port for a USB connected GPS to a Windows 10 computer:

1. Click Start → Settings → Devices → Connected-devices
2. The GPS should show up there as "Prolific USB-to-Serial Comm Port (COMx)". note which Comm port is listed, one example is COM6 GlobalSat BU-353 S4 (5Hz)
3. Make sure that no other programs are accessing the GPS.
4. Start up UDM, make sure you meter is selected
5. Select Log Continuous → GPS-tab
6. Enter the Comm Port into the Port: field, in my case I just typed in COM6
7. Enter the baud rate for the GPS into the Baud: field, in my case I just typed in 115200

**GPS on Mac** To get the Communications Port for a USB connected GPS to a Mac computer:

1. Follow the instructions for driver installation on the CD provided with the GPS
2. Connect the GPS
3. Open a terminal window
4. Type in: `ls -altr /dev/*` to look for the most recently created file that looks something like `cu.usbserial`
5. The newly connected GPS is located at something like `/dev/cu.usbserial`
6. Make sure that no other programs are accessing the GPS.
7. In UDM → Log-continuous → GPS → Port:, type in that filename. An example would be: `/dev/cu.usbserial`
8. Enter the baud rate for the GPS into the Baud: field, in my case I just typed in 115200
GPS and SQM startup procedure  Some computers reassign the communications port at power up or re-connection, so to ensure that the UDM can recognize both the SQM and the GPS, please follow these steps:

1. Disconnect the SQM and GPS from computer before powering up.
2. Power up the computer.
3. Start up UDM.
4. Connect the SQM and ensure you get a reading.
5. Disable the GPS connectivity from the log continuous tab.
6. Connect the GPS, and under the Log Continuous GPS tab ensure you are getting GPS location data.
7. Carry on from there.

GPS status  Upon succesful parsing of the GPS data, UDM illuminates (with bright green) the associated indicators (GPRMC, GPGGA, GPGSV). If too much time passes, the indicators fade to black.

The signal strength group shows the signal to noise ratio (SNR) for all visible satellites. The satellite number is displayed below each signal strength meter.

The location, speed, time, and status information is displayed as it is received.

If the GPS is enabled before logging, then the logfile is forced to "MOVING" platform mode, and five fields (latitude, longitude, elevation, speed, number of satellites in view) are appended to each record.

GoTo  A GoTo pointing device accessory can be controlled by UDM for the purpose of pointing the meter to various parts of the sky and automatically gathering a reading at each position.

The following GoTo devices are currently supported:

- SynScan V4
- iOptron 8408

The connection of the GoTo device is made to the serial port. Note; some USB to RS232 serial adapters do not act properly with UDM. Usually an FTDI addapter should work well.

Select the machine type, port, and baud rate. Ensure that the connected device is actually available on the port you select. In Windows, you can use the Device manager; In Mac and Linux, you can type `dmesg` on the command line in a terminal window to see the latest USB device attached.

A script file containing the positions is located in the “Data Directory” which is identified by:

View→Directories→Data_Directory.

On a Mac, you can use Finder to go to “Applications”, then right click on “udm” or “udm.app” then select “Show contents”. Then you can navigate to Contents→Resources to see the location of the *.goto file(s).

The format of the GoTo script file is a semicolon-separated file with an extension of “.goto”. Comment lines are preceded by the pound symbol (#). The second line defines the field format (Zenith;Azimuth). The remaining lines define the points to move to. An example is:

```
# Default
# Zenith;Azimuth
0;0
15;0
15;60
15;120
```

Control of the positioning is done from the trigger page. The “Goto accessory” and “Freshness” check boxes must be set. Pressing the "Record" button will start the pointing sequence.
7.5 Log Continuous

7.5.1 Import.dat into spreadsheet

The .dat file generated by UDM can be imported into a Microsoft Excel spreadsheet for calculations and graphing purposes as follows:

1. Start excel
2. File Open
3. Select "All files"
4. Select your .dat file (previously recorded and saved).
5. Select "delimited" (as opposed to the default "fixed width")
6. Import starting at line 33
7. Next
8. Unselect "Tab"
9. Select "Semicolon", you should see bars separating the data fields now.
10. Next
11. Define each field. European users will have to select "Advanced", then change the "Decimal point" to "." and "Thousands separator" to ",".
12. field 1,2 = date YMD

Note: You can also use the ".dat to Moon .csv" tool shown in Fig. 7.11 to create a comma separated variable file for importing into a spreadsheet like Excel.
7.6 Calibration tab

The Calibration tab is used to show and set the calibration data for the selected SQM device.

![Figure 7.36: Calibration tab (initial)](image)

Press the “Get Calibration Info” button so that the updated calibration data is brought in from the SQM on to the Actual values boxes as show below.

![Figure 7.37: Calibration tab (populated)](image)

Use the following steps to change the calibration values:

1. Enter the new calibration data on the left side entry box (Desired values column).
2. Press the associated “Set” button.
3. The value is sent to the SQM, and then confirmed in the right side box (Actual values column).

Note that temperatures set in to the SQM use their own resolution and may not be reflected as the same value entered. For example, 24.7°C might read back as 24.8 °C.
The original factory calibration values were provided on a paper with the shipped unit. If you have lost this information, please contact Unihedron to have the information emailed.

### 7.7 Report Interval tab

The Report Interval tab is used to show and set the report interval information for the selected SQM. Report interval settings are used to control the SQM to send readings out at a regular rate (in seconds) and only if darker than a specified threshold value. See section 8.8 on page 79 for more information about “Interval reporting”.

![Figure 7.38: Report interval tab](image)

Use the “R” button to temporarily set the value in to RAM for experimentation. The new value will be used instantly. The RAM value is set to the EEPROM value on power-up.

Use the “E/R” button to set the value in to EEPROM and RAM. The new value will be used instantly and also after power up.

Report interval is measured in seconds (i.e. 300 = 5 minutes).

Report threshold is measured in Magnitudes per square arcsecond (mpsas), a larger positive value is darker.

#### 7.7.1 Continuous reports

The Continuous reports section enables special features related to reporting through an optionally installed I2C interface except for the Ideal crossover function selection.

- **Reporting enabled**: The readings are sent to the I2C adapter as they are computed.
- **Reporting compressed**: High speed reporting is sent out in a compressed format.
- **Report un-averaged**: Send only the unaveraged readings to the I2C device.
- **LED blink accessory**: Enables the LED on the DL models to blink each time a reading is gathered.
- **Ideal crossover firmware**: See Theory of operation section 3.1 for full details.

### 7.8 Firmware tab

In a case where new firmware is supplied by Unihedron to correct bugs or add features, use this tab to select and load firmware in to the SQM-LE.
All available versions of firmware are shipped with the UDM software package in case you want to revert to an earlier firmware version for testing purposes. New firmware versions are announced on the Unihedron forum.

Follow these steps to load new firmware:

1. Press the “Select Firmware” button to choose the firmware file to load in to the SQM as shown in Figure 7.40:

2. Select the desired firmware file then press “Open”.

3. The “Load firmware” button will be enabled and you can press it now to start loading the firmware in to the SQM-LE. The status bar will indicate successful completion when the firmware has been completely loaded.

When using a Mac or Linux, the firmware can be loaded/restored using the “USB comm check” method when the associated buttons appear. The steps are shown as follows:

1. Start UDM
2. Have the meter connected
3. Go to the firmware tab
4. Select the appropriate firmware like SQM-LU-DL-4-6.67.hex
5. Press the "START UNPLUG METHOD button
6. Follow the instructions shown on the right side of the button.

### 7.8.1 XPort defaults

The SQM-LE comes shipped with the Ethernet XPort module default setting changed differently for use in the SQM-LE meter. Altering these settings with the web browser or Lantronix Device Installer may render the meter temporarily unusable.

Press the “XPort defaults” button on the “Firmware tab” page to reload the SQM-LE special settings.

### 7.9 Configuration tab

The “Configuration tab” shows the factory-set calibration values.

Calibration is performed at the Unihedron factory. A new calibration using a calibrated light source and darkroom can be performed by following the instructions on the right side of the screen. The calibration report can be logged to a data file and also printed out from this screen.

![Figure 7.41: Configuration tab](image)

Warning confirmations as shown in Figure 7.42 and Figure 7.43 are shown when trying to calibrate the unit yourself:

![Figure 7.42: Light calibration confirmation](image)
7.9.1 Sensor arrangement

For documentation purposes, the SQM-LE can store information on the sensor arrangement (starting at firmware feature 35 and above). The type of Lensholder, Lens, and Filter can be defined.

![Sensor arrangement](image)

7.9.2 Lock switch settings

The SQM-LE with firmware feature 46 and above has optional control of how the lock switch operates. The Lock switch always protects firmware upgrading, but it can optionally protect Calibration settings, Report Interval settings, and Configuration settings.

![Lock switch settings](image)

When the "These options" setting is checked, then none of the above settings can be changed while the unit is locked.

7.10 Simulation tab

The “Simulation” tab is enabled from the View menu.

The “Simulation” tab allows the simulation of raw light sensor values for experimentation purposes. The “Start” button initiates feeding the range of values to the internal formulas of the SQM-LE and results are displayed on this tab. Raw temperature conversions are detail in Eq: 8.1 and 8.2. The simulation will stop once all the steps are complete or when the “Stop” button is pressed.
When using the Simulation mode of the SQM-LE, make sure that nothing else interrupts the sequence of readings such as external programs reading from the SQM-LE, or settings of Interval reporting inside the SQM-LE.

### 7.10.1 Simulation from file

The “From file” button sends csv data from `simin.csv` (in the log file directory) to the SQM-LE in simulation mode and puts the output into `simout.csv`. The format of the csv is shown in Table 7.3:

<table>
<thead>
<tr>
<th>Position</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3000</td>
<td>Period in counts.</td>
</tr>
<tr>
<td>2</td>
<td>30</td>
<td>Frequency in Hz.</td>
</tr>
<tr>
<td>3</td>
<td>20.3</td>
<td>Temperature in °C.</td>
</tr>
</tbody>
</table>

The resultant output records will be shown on the screen and saved in `simout.csv` (in the log file directory) in the form of simulated result shown in section 8.9 as in the example shown in Listing 7.3:

```plaintext
0.568380,24.8
72970,6,13.2
```

Listing 7.3: simout.csv example
### 7.11 Accessory options

Some meters can be equipped/retro-fitted with optional accessories if they include firmware feature version ≥40. See section 8.6 for details on the accessory commands.

The accessories tab (shown in Figure 7.47) is available when selecting a device that has the appropriate firmware:

![Figure 7.47: Accessories tab](image)

#### 7.11.1 Humidity accessory

There are currently two types of I²C humidity sensors that have been tested; HIH8120, and HYT939. The selection can be made with the drop down combo-box on this tab.

Enabling this sensor allows the SQM-LE to poll the sensor once per second to gather a reading which can be requested later with the A1x command.

The refresh button requests the most recent value that the SQM-LE has collected.

The Status field shows the status of the humidity sensor which is updated after the refresh button is pressed. The status is ‘N/C’ when the sensor is not connected.

#### 7.11.2 Display accessory

A 4-digit 7-segment I²C display can be attached to the SQM-LE. Currently only the Sparkfun COM-11441 has been tested.

This display shows the brightness reading in mpsas.

The brightness of the display can be fixed at a level between 0-7 (dimmest to brightest), or can be automatically dimmed in bright conditions (depending on the mpsas reading).

The display can be either updated periodically (1Hz) or whenever a reading request is made.

#### 7.11.3 LED accessory

The LED indicator accessory is mainly used for troubleshooting to identify either when readings are created or requested.

The LED blinks for 1/60th of a second.

The LED can blink either when the SQM-LE creates a reading, of when a reading is requested (using the rx command).

#### 7.11.4 Relay accessory

The Relay accessory is mainly used for dew heater control. A 3.3V activated solid state relay can be connected directly to pin 23 of the microcontroller (25mA drive maximum).

When in Manual mode, the relay can be turned on or off.

When in Automatic mode, the relay is turned on when the mpsas reading is above the threshold and off when the mpsas reading is below the threshold.

Pressing the On/Off buttons while the relay is in automatic mode will switch it to manual mode.
7.12 Command line parameters

UDM can be started from the command line. Other stored parameters (like timezone) will be recalled automatically. Here is the summary of options:

**Table 7.4: Log continuous command line parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-LCMS,x</td>
<td>Every x seconds</td>
</tr>
<tr>
<td>-LCMM,x</td>
<td>Every x minutes</td>
</tr>
<tr>
<td>-LCM,1</td>
<td>Every 1 minute on the minute</td>
</tr>
<tr>
<td>-LCM,5</td>
<td>Every 5 minutes on the 1/12th hour</td>
</tr>
<tr>
<td>-LCM,10</td>
<td>Every 10 minutes on the 1/6th hour</td>
</tr>
<tr>
<td>-LCM,15</td>
<td>Every 15 minutes on the 1/4 hour</td>
</tr>
<tr>
<td>-LCM,30</td>
<td>Every 30 minutes on the 1/2 hour</td>
</tr>
<tr>
<td>-LCM,60</td>
<td>Every hour on the hour</td>
</tr>
<tr>
<td>-LCR</td>
<td>Start recording right away</td>
</tr>
<tr>
<td>-LCMIN</td>
<td>Minimize Application after Log continuous window starts up</td>
</tr>
<tr>
<td>-LCTH,x</td>
<td>Threshold setting. Readings equal to or greater than x (in mpsas) get recorded. If x=0 then all readings are get recorded.</td>
</tr>
<tr>
<td>-LCGRS</td>
<td>Run GoTo script then shut down when done</td>
</tr>
</tbody>
</table>

**Table 7.5: Select device command line parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-SEI,x</td>
<td>Select Ethernet device where x = IP address</td>
</tr>
<tr>
<td>-SEM,x</td>
<td>Select Ethernet device where x = MAC address</td>
</tr>
<tr>
<td>-SUC,x</td>
<td>Select USB device where x = communication portname i.e. /tty/USB0</td>
</tr>
<tr>
<td>-SUI,x</td>
<td>Select USB device where x = ID number ex FTD12345</td>
</tr>
</tbody>
</table>

**Table 7.6: Select features command line parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-N</td>
<td>Do not search for devices at startup. This cuts down startup time, the user must press the Find button to find devices.</td>
</tr>
<tr>
<td>-P</td>
<td>Display plotter window.</td>
</tr>
<tr>
<td>-TCA</td>
<td>Start up Concatenate/Analyze tool</td>
</tr>
<tr>
<td>-TCM</td>
<td>Start up Cloud removal / Milky way position tool</td>
</tr>
<tr>
<td>-TCMR</td>
<td>Start up Cloud removal / Milky way position tool, and recall previous filename</td>
</tr>
</tbody>
</table>
7 Unihedron Device Manager

7.12.1 Internal startup options
UDM also has the ability to store the startup options internally so that no extra command line parameters are required. You can access this setting from File -> Startup options menu.

7.12.2 Windows autostartup
An example for the Windows shortcut, in the Target, put the command in quotations and add the command line parameters to the end like this example to find the USB device with USB ID 12345678 and starts logging to disk:
"C:\Users\User\AppData\Local\Unihedron\udm.exe" -SUI,12345678 -LCR
You can leave out the above optional parameters from the command line if you include those in the internal startup options in the UDM File -> Startup options menu.

7.12.3 Mac autostartup
You can have UDM start up when you login to your Mac. Enter your UDM startup parameters in the UDM File -> Startup options menu. Then add UDM to the Mac Login items as follows:

- Go to System Preferences > Users & Groups from the main Mac menu.
- Select your user account in the list on the left.
- Click Login Items.
- Click the Add button.
- Select UDM from the Applications folder.
8 Commands and responses

The SQM-LE accepts a sequence of characters as a command, then executes those commands and usually provides a response of a sequence of characters. The following details are useful when programming your own interface to send data to and receive data from the SQM-LE.

8.1 Commands

Commands consist of a string of characters. The first character is the command type. The following is a list of the “Standard” commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>rx</td>
<td>Reading request.</td>
</tr>
<tr>
<td>cx</td>
<td>Calibration information request.</td>
</tr>
<tr>
<td>ix</td>
<td>Unit information request (note lower case “i”).</td>
</tr>
<tr>
<td>zcalAx</td>
<td>Arm Light Calibration command.</td>
</tr>
<tr>
<td>zcalBx</td>
<td>Arm Dark Calibration command.</td>
</tr>
<tr>
<td>zcalDx</td>
<td>Disarm Calibration command.</td>
</tr>
<tr>
<td>zcal5</td>
<td>Manually Set Light Calibration Offset.</td>
</tr>
<tr>
<td>zcal6</td>
<td>Manually Set Light Calibration Temperature.</td>
</tr>
<tr>
<td>zcal7</td>
<td>Manually Set Dark Calibration Time Period.</td>
</tr>
<tr>
<td>zcal8</td>
<td>Manually Set Dark Calibration Temperature.</td>
</tr>
<tr>
<td>0x19</td>
<td>Reset micro-controller. Hexadecimal value 19. See the “Firmware Upgrade” chapter on page 88 for more details.</td>
</tr>
<tr>
<td>:</td>
<td>Intel Hex firmware upgrade initiation. See the “Firmware Upgrade” chapter on page 88 for more details.</td>
</tr>
<tr>
<td>P...x</td>
<td>Set period (in seconds) for interval reporting to EEPROM and RAM for booting and immediate use. Firmware feature=13.</td>
</tr>
<tr>
<td>p...x</td>
<td>Set period (in seconds) for interval reporting to RAM for immediate use. Firmware feature≥13.</td>
</tr>
<tr>
<td>T...x</td>
<td>Set threshold (in ( \frac{mag}{arcsec^2} )) for interval reporting only to EEPROM and RAM for booting and immediate use. Firmware feature≥13.</td>
</tr>
<tr>
<td>t...x</td>
<td>Set threshold (in ( \frac{mag}{arcsec^2} )) for interval reporting only to RAM for immediate use. Firmware feature≥13.</td>
</tr>
<tr>
<td>sx</td>
<td>Request reading of internal variables.</td>
</tr>
<tr>
<td>S...x</td>
<td>Simulate internal calculations.</td>
</tr>
</tbody>
</table>
8 Commands and responses

8.2 Response details

8.2.1 Reading request

The “Reading” request “rx” or “Rx” commands the SQM-LE to provide the current darkness value as well as all variables used to generate that result.

Readings produced by this request are averaged internally by using the last 8 readings and shifting those values through an 8 cell buffer then summing and dividing by 8. Use the “ux” command to get the un-averaged and most recent value.

Averaging is only performed on period-mode readings (when the light sensor frequency is below 128Hz). Frequency mode readings (above 128Hz) are automatically averaged because the reading is taken from a one second sampling of pulses.

The format of the response is shown in table 8.2:

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>r</td>
<td>Indicates that a reading is being returned.</td>
</tr>
<tr>
<td>2-8</td>
<td>0.6.70m</td>
<td>Reading in $\frac{\text{mag}}{\text{arcsec}}$. Leading space for positive value. Leading negative sign (-) for negative value. A reading of 0.00m means that the light at the sensor has reached the upper brightness limit of the unit.</td>
</tr>
<tr>
<td>10-21</td>
<td>00000022921Hz</td>
<td>Frequency of sensor in Hz.</td>
</tr>
<tr>
<td>23-33</td>
<td>00000000020c</td>
<td>Period of sensor in counts. Counts occur at a rate of 460.8 kHz (14.7456MHz/32).</td>
</tr>
<tr>
<td>35-46</td>
<td>0000000.000s</td>
<td>Period of sensor in seconds with millisecond resolution. Determined by dividing the above counts value by 460800.</td>
</tr>
<tr>
<td>48-54</td>
<td>0.39.4C</td>
<td>Temperature measured at light sensor in degrees C. The value is averaged and presented every 4.3 seconds. Leading space for positive value. Leading negative sign (-) for negative value.</td>
</tr>
<tr>
<td>55-56</td>
<td></td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
</tr>
</tbody>
</table>

An example of the response is:
```
r, 06.70m,0000022921Hz,000000020c,0000000.000s, 039.4C
0123456789 123456789 123456789 123456789 123456789 123456
```

Future versions of this reading string will only modify reported values beyond position 54. Characters 0 to 54 may be considered stable.

A special case “Rx” command returns the serial number in the same format as the interval report does. See page 79 “Setting Interval reporting parameters” for report details.

8.2.2 Unaveraged reading request

The “unaveraged reading” request “ux” commands the meter to provide the current darkness value as well as all variables used to generate that result. This readings is not averaged out like the “rx” command.

The format of the response is shown in table 8.3:
### 8.2 Response details

#### Table 8.3: Unaveraged reading request response

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>u</td>
<td>Indicates that a reading is being returned.</td>
</tr>
<tr>
<td>2-8</td>
<td>.06.70m</td>
<td>Reading in ( \text{mag arcsec} ). Leading space for positive value. Leading negative sign (-) for negative value. A reading of 0.00m means that the light at the sensor has reached the upper brightness limit of the unit.</td>
</tr>
<tr>
<td>10-21</td>
<td>0000022921Hz</td>
<td>Frequency of sensor in Hz.</td>
</tr>
<tr>
<td>23-33</td>
<td>00000000020c</td>
<td>Period of sensor in counts. Counts occur at a rate of 460.8 kHz (14.7456MHz/32).</td>
</tr>
<tr>
<td>35-46</td>
<td>000000.000s</td>
<td>Period of sensor in seconds with millisecond resolution. Determined by dividing the above counts value by 460800.</td>
</tr>
<tr>
<td>48-54</td>
<td>.039.4C</td>
<td>Temperature measured at light sensor in degrees C. The value is averaged and presented every 4.3 seconds. Leading space for positive value. Leading negative sign (-) for negative value.</td>
</tr>
<tr>
<td>55-56</td>
<td></td>
<td>Carriage return (0xd), Line feed (0xa).</td>
</tr>
</tbody>
</table>

An example of the response is:

\[ u, 06.70m,0000022921Hz,0000000020c,000000.000s, 039.4C \]

0123456789 123456789 123456789 123456789 123456789 123456789 123456

Future versions of this reading string will only modify reported values beyond position 54. Characters 0 to 54 may be considered stable.

#### 8.2.3 Linear reading request

The “linear reading” request “rfx” commands the meter to provide the current brightness value proportional to the light flux or frequency output from the light sensor. This value is compensated for only by the dark current frequency.

\[
\text{f}_{\text{out}} = \text{f}_{\text{light}} - \text{f}_{\text{dark}}
\]

To allow for long period measurements, the output integer value is scaled up by a factor of 45,000.

\[
\text{n}_{\text{out}} = \text{f}_{\text{out}} \times 45000
\]

The format of the response is shown in table 8.4:

#### Table 8.4: Linear reading request response

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-1</td>
<td>f,</td>
<td>Indicates that a frequency reading is being returned.</td>
</tr>
</tbody>
</table>

\( \text{Table continued on next page} \)...


Table 8.4 – continued from previous page

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
</table>
| 2-11   | 0001287103    | Frequency reading.  
A reading of 0000045000 would indicate a sensor frequency of 1Hz, but the meter limits to 25kHz for later scaling of snow factor, so the maximum value would be 1125045000 (25kHz × 45000).  
A reading of 0000000000 would indicate total darkness, but the meter limits time readings to 85 seconds maximum, so the darkest value would be 0000000529 (\( \frac{1}{85s} \times 45000 \)). |
| 55-56  |               | Carriage return (0x0d), Line feed (0x0a). |

An example of the response is:
```
f,0001287103
0123456789 123
```

### 8.2.4 Inline linear reading request

The “inline linear reading” request “rFx” (note: capital F) commands the meter to include the current brightness value proportional to the light flux or frequency output from the light sensor. This value is compensated for only by the dark current frequency.  

\[
f_{\text{out}} = f_{\text{light}} - f_{\text{dark}}
\]

To allow for long period measurements, the output integer value is scaled up by a factor of 45,000.  

\[
n_{\text{out}} = f_{\text{out}} \times 45000
\]

The format of the response is similar to the “rx” response and is shown in table 8.5:

Table 8.5: Inline linear reading request response

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>r</td>
<td>Indicates that a reading is being returned.</td>
</tr>
</tbody>
</table>
| 2-8    | .06 .70m      | Reading in \( \frac{\text{mJy}}{\text{arcsec}^2} \).  
Leading space for positive value.  
Leading negative sign (-) for negative value.  
A reading of 0.00m means that the light at the sensor has reached the upper brightness limit of the unit. |
| 10-21  | 0000022921Hz  | Frequency of sensor in Hz. |
| 23-33  | 00000000020c  | Period of sensor in counts. Counts occur at a rate of 460.8 kHz (14.7456MHz/32). |
| 35-46  | 0000000.000s  | Period of sensor in seconds with millisecond resolution. Determined by dividing the above counts value by 460800. |

Table continued on next page ...
8.2 Response details

Table 8.5 – continued from previous page

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>48-54</td>
<td>_039.4C</td>
<td>Temperature measured at light sensor in degrees C. The value is averaged and presented every 4.3 seconds. Leading space for positive value. Leading negative sign (-) for negative value.</td>
</tr>
<tr>
<td>56-65</td>
<td>0001287103</td>
<td>Frequency reading. A reading of 0000045000 would indicate a sensor frequency of 1Hz, but the meter limits to 25kHz for later scaling of snow factor, so the maximum value would be 1125045000 (25kHz × 45000). A reading of 0000000000 would indicate total darkness, but the meter limits time readings to 85 seconds maximum, so the darkest value would be 00000000529 ((\frac{1}{85s} \times 45000)).</td>
</tr>
<tr>
<td>66-67</td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
<td></td>
</tr>
</tbody>
</table>

An example of the response is:
r, 06.70m,0000022921Hz,0000000020c,0000000.000s, 039.4C,0001287103
0123456789 123456789 123456789 123456789 123456789 123456789 12345

8.2.5 Unit information

Unit information command “ix” provides details about the software in the micro-controller. The format of the response is:

Table 8.6: Unit information request response

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>i</td>
<td>Indicates that the unit information response is being returned.</td>
</tr>
<tr>
<td>2-9</td>
<td>00000002</td>
<td><strong>Protocol number</strong> (8 digits). This will always be the first 8 characters (after the “i,” response). This value indicates the revision number of the data protocol to/from the SQM-LE. The protocol version is independent of the feature version.</td>
</tr>
<tr>
<td>11-18</td>
<td>00000003</td>
<td><strong>Model number</strong> (8 digits). The model value identifies the specific hardware model that the firmware is tailored for.</td>
</tr>
<tr>
<td>20-27</td>
<td>00000001</td>
<td><strong>Feature number</strong> (8 digits). The feature value identifies software features. This number is independent of the data protocol.</td>
</tr>
<tr>
<td>29-36</td>
<td>00000413</td>
<td><strong>Serial number</strong> (8 digits). Each unit has its own unique serial number.</td>
</tr>
<tr>
<td>37-38</td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
<td></td>
</tr>
</tbody>
</table>

An example of the response is:
i,00000002,00000003,00000001,00000413
0123456789 123456789 123456789 123456789 123456789 123456789 12345
8 Commands and responses

8.3 Calibration commands

8.3.1 Calibration information request

The calibration information request “cx” returns all data about the specific light sensor in the unit required to calculate a reading.

The format of the response is shown in table 8.7:

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>c</td>
<td>Indicates that the calibration information is being returned.</td>
</tr>
<tr>
<td>2-13</td>
<td>00000017.60m</td>
<td>Light calibration offset in $\text{mag arcsec}$.</td>
</tr>
<tr>
<td>15-26</td>
<td>0000000.000s</td>
<td>Dark calibration time period in seconds with millisecond resolution.</td>
</tr>
<tr>
<td>28-34</td>
<td>.039.4C</td>
<td>Temperature in degrees C measured during light calibration. Leading space for positive value. Leading negative sign (-) for negative value.</td>
</tr>
<tr>
<td>36-47</td>
<td>00000008.71m</td>
<td>Offset of light sensor in $\text{mag arcsec}$ based on manufacturing reference. The factory calibration light source is equivalent to 8.71 $\text{mag arcsec}$, and when the “Light calibration” button is pressed in UDM, the meter creates the light calibration offset value (17.60 in this case) so that the meter reads 8.71 also.</td>
</tr>
<tr>
<td>49-55</td>
<td>.039.4C</td>
<td>Temperature in degrees C measured during dark calibration. Leading space for positive value. Leading negative sign (-) for negative value.</td>
</tr>
<tr>
<td>56-57</td>
<td></td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
</tr>
</tbody>
</table>

An example of the response is:

c,00000017.60m,0000000.000s,.039.4C,00000008.71m,.039.4C
0123456789 123456789 123456789 123456789 123456789 1234567

8.3.2 Light calibration command

Calibration of the SQM-LE is done at the factory in a controlled light and temperature environment.

Executing the Light calibration command “zcalAx” arms the light calibration mode.

Flipping the switch on the back of the SQM-LE to “unlock” triggers the light calibration and modifies the calibration values in the unit.

A calibrated light source of approximately 13.5fc is supplied to the sensor.

The format of the response is shown in table 8.8:

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>z</td>
<td>Indicates that a “Calibration” response is being returned.</td>
</tr>
<tr>
<td>1</td>
<td>A</td>
<td>Indicates Light Calibration mode.</td>
</tr>
<tr>
<td>2</td>
<td>a</td>
<td>Indicates that the calibration is armed.</td>
</tr>
</tbody>
</table>

Table continued on next page ...
8.3 Calibration commands

Table 8.8 – continued from previous page

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
</table>
| 3      | L             | L = Locked; Wait for unlock before calibrating after Arm command, firmware upgrades are disabled.  
U = Unlocked; Calibrate immediately after Arm command, Enable firmware upgrade. |
| 4-5    |               | Carriage return (0x0d), Line feed (0x0a). |

An example of the response is:

```
zAaL
012345
```

8.3.3 Dark calibration command

Dark Calibration is done at the factory along with Light calibration and calibration temperature recording.

Executing the dark calibration command “`zcalBx`” arms the dark calibration mode.

Flipping the switch on the back of the SQM-LE to “unlock” triggers the dark calibration and modifies the calibration values in the unit.

Dark calibration is performed in a completely dark environment. Check a reading to ensure that the period is correct after entering the dark environment, it could take a few minutes to collect an accurate dark period. A dark period of only a few seconds is too small.

The format of the response is shown in table 8.9:

Table 8.9: Dark calibration response

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>z</td>
<td>Calibration response is being returned.</td>
</tr>
<tr>
<td>1</td>
<td>B</td>
<td>Dark Calibration.</td>
</tr>
<tr>
<td>2</td>
<td>a</td>
<td>Armed.</td>
</tr>
</tbody>
</table>
| 3      | L             | L = Locked; Wait for unlock before calibrating after Arm command, firmware upgrades are disabled.  
U = Unlocked; Calibrate immediately after Arm command, Enable firmware upgrade. |
| 4-5    |               | Carriage return (0x0d), Line feed (0x0a). |

An example of the response is:

```
zBaL
012345
```

8.3.4 Disarm calibration command

The Disarm calibration command “`zcalDx`” disarms calibration modes from being triggered by the unlock mode.

The format of the response is shown in table 8.10:
Table 8.10: Disarm calibration response

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>z</td>
<td>Calibration response is being returned.</td>
</tr>
<tr>
<td>1</td>
<td>x</td>
<td>Indicates “All” calibration modes.</td>
</tr>
<tr>
<td>2</td>
<td>d</td>
<td>Disarmed.</td>
</tr>
<tr>
<td>3</td>
<td>L</td>
<td>L = Locked; Wait for unlock before calibrating after Arm command, firmware upgrades are disabled. U = Unlocked; Calibrate immediately after Arm command, Enable firmware upgrade.</td>
</tr>
<tr>
<td>4-5</td>
<td></td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
</tr>
</tbody>
</table>

An example of the response is:

```
zxdL
012345
```

### 8.3.5 Manually set light calibration offset

Calibration is done at the factory, however, in the case where calibration values must be restored or set to something else, this command allows a new calibration value to be placed into the meter.

Executing the command “zcal5########.##x” manually sets the light calibration offset to the value specified in “########.##”. The units are $\text{magnitudes arcsecond}^2$.

The format of the response is shown in table: 8.11:

Table 8.11: Response for manual setting of light calibration offset

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>z</td>
<td>Calibration response is being returned.</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
<td>Manual Set Light Calibration Offset</td>
</tr>
<tr>
<td>4-15</td>
<td>00000017.60m</td>
<td>Value that was set into EEPROM</td>
</tr>
<tr>
<td>16-17</td>
<td></td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
</tr>
</tbody>
</table>

An example of the response is:

```
z,5,00000017.60m
0123456789 1234567
```

### 8.3.6 Manually set light calibration temperature

Calibration is done at the factory, however, in the case where calibration values must be restored or set to something else, this command allows a new calibration value to be placed into the meter.

The “Light calibration temperature” is the temperature of the meter when the meter was calibrated for its “Light calibration offset”.

Executing the command “zcal6########.##x” manually sets the light calibration temperature to the value specified in “########.##”. The units are °C.

Note: The meter records the temperature in a raw value with different resolution, so the reply back may not be exactly the same as the value sent.

The format of the response is shown in table: 8.12:
8.3 Calibration commands

Table 8.12: Response for manually setting of light calibration temperature

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>z</td>
<td>Calibration response is being returned.</td>
</tr>
<tr>
<td>2</td>
<td>6</td>
<td>Manual Set Light Calibration Offset</td>
</tr>
<tr>
<td>4-9</td>
<td>019.0°C</td>
<td>Value that was set into EEPROM</td>
</tr>
<tr>
<td>10-11</td>
<td></td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
</tr>
</tbody>
</table>

An example of the response is:

z,6,019.0C
0123456789 1

8.3.7 Manually set dark calibration time period

Calibration is done at the factory, however, in the case where calibration values must be restored or set to something else, this command allows a new calibration value to be placed into the meter.

The “Dark calibration time period” is the amount of time that has elapsed for the light sensor to make one cycle while in complete darkness. The meter sets a time limit of 300 seconds on this value.

Executing the command “zcal7#######.###x” manually sets the light calibration offset to the value specified in “#######.###”. The units are in seconds.

The format of the response is shown in table: 8.13:

Table 8.13: Response of manually setting dark calibration time period

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>z</td>
<td>Calibration response is being returned.</td>
</tr>
<tr>
<td>2</td>
<td>7</td>
<td>Manual Set Dark Calibration time period.</td>
</tr>
<tr>
<td>4-15</td>
<td>0000300.000s</td>
<td>Value that was set into EEPROM</td>
</tr>
<tr>
<td>16-17</td>
<td></td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
</tr>
</tbody>
</table>

An example of the response is:

z,7,00000300.00s
0123456789 1234567

8.3.8 Manually set dark calibration temperature

Calibration is done at the factory, however, in the case where calibration values must be restored or set to something else, this command allows a new calibration value to be placed into the meter.

The “Dark calibration temperature” is the temperature of the meter when the meter was calibrated for its “Dark calibration time period”.

Executing the command “zcal8########.##x” manually sets the light calibration offset to the value specified in “########.##”. The units are °C.

Note: The meter records the temperature in a raw value with different resolution, so the reply back may not be exactly the same as the value sent.

The format of the response is shown in table: 8.14:
Table 8.14: Response for manually setting of dark calibration temperature

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>z</td>
<td>Calibration response is being returned.</td>
</tr>
<tr>
<td>2</td>
<td>8</td>
<td>Manual Set Dark Calibration temperature.</td>
</tr>
<tr>
<td>4-9</td>
<td>019.0C</td>
<td>Value that was set into EEPROM</td>
</tr>
<tr>
<td>10-11</td>
<td></td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
</tr>
</tbody>
</table>

An example of the response is:

```
z,8,019.0C
0123456789 1
```
8.4 Lock settings

Firmware feature $\geq 46$ allows fine control of how the lock switch operates.

It is recommended that all changes be made with the lock switch in the unlocked position otherwise the "these settings" set to true will render other settings unchangeable.

The command Kx will return the status of the Lock settings (see response below).

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kx</td>
<td>Report the Lock setting status.</td>
</tr>
</tbody>
</table>

Change the Lock setting (where $m=C,c,R,r,G,g,T,t$) as follows:

- $C =$ Calibration changes respect the lock setting.
- $c =$ Calibration changes ignore the lock setting.
- $R =$ Report Interval changes respect the lock setting.
- $r =$ Report Interval ignore the lock setting.
- $G =$ Configuration changes respect the lock setting.
- $g =$ Configuration changes ignore the lock setting.
- $T =$ These setting changes respect the lock setting.
- $t =$ These setting changes ignore the lock setting.

An example response to "Kx" is:

$K, crGT$

8.5 Snow LED accessory

An LED used for determining snow cover on the meter can be attached to an internal pin of the SQM-LE. This LED shines green light out of the meter and the light sensor will see a reflection if snow is covering the meter (housing cap). The light meter reading will be unchanged with no snow present, and about $1.6 \text{mag/arcsec}^2$ brighter with snow cover present.
### 8 Commands and responses

#### Table 8.17: Snow LED accessory command summary

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A50x</td>
<td>Turn off the Snow LED accessory.</td>
</tr>
<tr>
<td>A51x</td>
<td>Turn on the Snow LED accessory.</td>
</tr>
<tr>
<td>A5ex</td>
<td>Enable Snow LED logging (while on battery power).</td>
</tr>
<tr>
<td>A5dx</td>
<td>Disable Snow LED logging (while on battery power).</td>
</tr>
<tr>
<td>A5x</td>
<td>LED accessory status.</td>
</tr>
</tbody>
</table>

#### Table 8.18: Snow LED accessory response summary

<table>
<thead>
<tr>
<th>Position</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-2</td>
<td>A5,</td>
<td>Confirmation Snow LED accessory command.</td>
</tr>
<tr>
<td>3</td>
<td>n</td>
<td>Where ( n = 0 ) indicates the Snow LED is Off. 1 indicates the Snow LED is On.</td>
</tr>
<tr>
<td>4</td>
<td>m</td>
<td>Where ( m = 0 ) indicates the Snow LED is disabled. 1 indicates the Snow LED is enabled.</td>
</tr>
</tbody>
</table>

Carriage return (0x0d), Line feed (0x0a).

An example response to “A5x” is:

A5, 0
8.6 Accessories commands

Some I²C accessory devices can be connected to the SQM-LE when using firmware feature version 44 and above. These devices are connected by way of retrofitted wiring inside the unit or a future back panel connector.

All of the SQM-LE accessory commands begin with “A” (upper case).

8.6.1 Humidity / Temperature sensor

Two I²C humidity/temperature sensors models can be connected to the SQM-LE. All commands (seen in table 8.19) to this accessory result in a response (seen in table 8.20).

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1Ex</td>
<td>Enable the humidity temperature accessory.</td>
</tr>
<tr>
<td>A1Dx</td>
<td>Disable the humidity temperature accessory.</td>
</tr>
<tr>
<td>A1Mmx</td>
<td>Set the model number (where ( m = 0-7 )) of the humidity temperature accessory: 0=HIH8120 1=HYT939 (Sold by ControlEverything and others)</td>
</tr>
<tr>
<td>A1x</td>
<td>Report on the humidity temperature status.</td>
</tr>
</tbody>
</table>

Table 8.19: Humidity/temperature command summary

<table>
<thead>
<tr>
<th>Position</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>A,1,</td>
<td>Confirmation of humidity/temperature accessory command.</td>
</tr>
<tr>
<td>1</td>
<td>1,</td>
<td>Accessory 1 (Humidity/temperature sensor).</td>
</tr>
<tr>
<td>2</td>
<td>e,</td>
<td>E for enabled.  D for disabled.</td>
</tr>
<tr>
<td>3</td>
<td>m,</td>
<td>Model number (where ( m = 0-7 )): 0=HIH8120 1=HYT939 (Sold by ControlEverything and others)</td>
</tr>
<tr>
<td>4</td>
<td>s</td>
<td>Status (0-3).  0 = Normal Operation, Valid Data that has not been fetched since the last measurement cycle.  1 = Stale Data: Data that has already been fetched since the last measurement cycle, or data fetched before the first measurement has been completed.  2 = Sensor in Command Mode.  3 = Not used.</td>
</tr>
<tr>
<td>5</td>
<td>nnnnn</td>
<td>Humidity(%)RH = ( \frac{nnnnn}{2^{14}} \times 100 ).  16383 when no connection.</td>
</tr>
<tr>
<td>6</td>
<td>nnnnn</td>
<td>Temperature(°C) = ( \frac{nnnnn}{2^{14}} \times 165 - 40 ).  16383 when no connection.</td>
</tr>
</tbody>
</table>

An example response to “A1x” is:
A,1,E,1,0,07788,06202
8 Commands and responses

8.6.2 Display accessory

An I²C 4-digit 7-segment display made by Sparkfun (model COM-11441) can be connected. All commands (seen in table 8.21) to this accessory result in a response (seen in table 8.22).

Readings that are too bright for the SQM-LE will show up as □ □ □ . Readings that are too dark for the meter will show up as □ □ □ □ .

Table 8.21: Display accessory command summary

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A2Ex</td>
<td>Enable the display accessory.</td>
</tr>
<tr>
<td>A2Dx</td>
<td>Disable the display accessory.</td>
</tr>
<tr>
<td>A2Fx</td>
<td>Fixed mode of brightness.</td>
</tr>
<tr>
<td>A2Ax</td>
<td>Auto mode of brightness. Lowers brightness on dark nights. Display at lowest brightness (30%) when greater than 19.00 mpsas. Display at medium brightness (50%) between 17.00 to 19.00 mpsas. Display at full brightness (100%) when less than 17.00 mpsas.</td>
</tr>
<tr>
<td>A2Mnx</td>
<td>Set the model of display (where n = 0-3).</td>
</tr>
<tr>
<td>A2Vnx</td>
<td>Set the fixed mode brightness (where n = 0-7).</td>
</tr>
<tr>
<td>A2Px</td>
<td>Set the updating mode to periodically updating at 1Hz.</td>
</tr>
<tr>
<td>A2Rx</td>
<td>Set the updating mode to updating when reading request is made.</td>
</tr>
<tr>
<td>A2x</td>
<td>Report on the display status.</td>
</tr>
</tbody>
</table>

Table 8.22: Display accessory response summary

<table>
<thead>
<tr>
<th>Position</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>A,</td>
<td>Confirmation of display accessory command.</td>
</tr>
<tr>
<td>1</td>
<td>2,</td>
<td>Accessory 2 (Display).</td>
</tr>
<tr>
<td>2</td>
<td>e,</td>
<td>E for enabled. D for disabled.</td>
</tr>
<tr>
<td>3</td>
<td>m,</td>
<td>Model number (where m = 0-3).</td>
</tr>
<tr>
<td>4</td>
<td>m,</td>
<td>F = Fixed mode. A = Auto mode. See table 8.21 for description.</td>
</tr>
<tr>
<td>5</td>
<td>n,</td>
<td>Fixed brightness level (where n = 0-7).</td>
</tr>
<tr>
<td>6</td>
<td>m</td>
<td>P = periodically updating at 1Hz R = updating when reading request is made. Carriage return (0x0d), Line feed (0x0a).</td>
</tr>
</tbody>
</table>

An example response to “A2x” is: A, 2, E, 0, F, 2, R
8.6.3 LED accessory

For purposes of troubleshooting, an LED with series resistor can be connected to an internal pin of the SQM-LE. All commands (seen in table 8.23) to this accessory result in a response (seen in table 8.24).

Using the LED to indicate when a reading is being requested is an ideal method to determine if the controlling software is actually accessing the SQM-LE.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A3Ex</td>
<td>Enable the LED accessory.</td>
</tr>
<tr>
<td>A3Dx</td>
<td>Disable the LED accessory.</td>
</tr>
<tr>
<td>A30x</td>
<td>Mode=Blink at reading creation. In bright sky conditions, readings are created once per second in frequency-mode. In darker sky conditions, the meter goes into period-mode starting at 679Hz and lower, and LED will blink at a variable rate.</td>
</tr>
<tr>
<td>A31x</td>
<td>Mode=Blink at reading request.</td>
</tr>
<tr>
<td>A3x</td>
<td>LED accessory status.</td>
</tr>
</tbody>
</table>

Table 8.24: LED accessory response summary

<table>
<thead>
<tr>
<th>Position</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>A,</td>
<td>Confirmation of display accessory command.</td>
</tr>
<tr>
<td>1</td>
<td>3,</td>
<td>Accessory 3 (LED).</td>
</tr>
<tr>
<td>2</td>
<td>e,</td>
<td>E for enabled. D for disabled.</td>
</tr>
<tr>
<td>3</td>
<td>m,</td>
<td>Model number (where $m = 0-7$). 0 = LED connected to pin-13 through 1k resistor to ground.</td>
</tr>
<tr>
<td>4</td>
<td>m,</td>
<td>Mode of operation (where $m = 0-1$): 0 = Blink at reading creation. 1 = Blink at reading request.</td>
</tr>
</tbody>
</table>

An example response to “A2x” is:
A,3,E,0,1
8 Commands and responses

8.6.4 Relay accessory

A Solid State Relay (SSR) accessory may be connected to the SQM-LE for generic use or for purposes of implementing a dew-heater control. All commands (seen in table 8.25) to this accessory result in a response (seen in table 8.26).

Table 8.25: Relay accessory command summary

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4x</td>
<td>Get status of the relay accessory.</td>
</tr>
<tr>
<td>A40x</td>
<td>Deactivate the relay accessory. Also places the accessory into manual mode.</td>
</tr>
<tr>
<td>A41x</td>
<td>Activate the relay accessory. Also places the accessory into manual mode.</td>
</tr>
<tr>
<td>A4Mnx</td>
<td>Set the mode of operation: 0=Light threshold activated. 1=Dewpoint activation. 2=Heat activated. 3-6=future use. 7=Manual mode where only the A40x and A41x commands affect the relay activation.</td>
</tr>
<tr>
<td>A4Tnx</td>
<td>Set the darkness threshold for relay activation. Where nn is the the darkness threshold. The relay will be activated above this threshold. Monitoring is performed once per second.</td>
</tr>
</tbody>
</table>

Table 8.26: Relay accessory response summary

<table>
<thead>
<tr>
<th>Position</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>A,</td>
<td>Confirmation of display accessory command.</td>
</tr>
<tr>
<td>1</td>
<td>4,</td>
<td>Accessory 3 (relay).</td>
</tr>
<tr>
<td>2</td>
<td>s,</td>
<td>Status of device: 0 for deactivated relay. 1 for activated relay.</td>
</tr>
<tr>
<td>3</td>
<td>m,</td>
<td>Mode of operation (where m=0-7): 0 = Light mode. 1 = Dewpoint mode. 2 = Heat mode. 7 = Manual mode.</td>
</tr>
<tr>
<td>4</td>
<td>nn</td>
<td>Threshold of darkness (in mpsas) for automatic mode of operation.</td>
</tr>
<tr>
<td>5</td>
<td>ttt</td>
<td>Temperature (°C) used for dewpoint calculation.</td>
</tr>
<tr>
<td>6</td>
<td>hhh</td>
<td>Humidity (%RH) used for dewpoint calculation.</td>
</tr>
<tr>
<td>7</td>
<td>ddd</td>
<td>Dewpoint temperature (°C) used for dewpoint calculation.</td>
</tr>
</tbody>
</table>

Carriage return (0x0d), Line feed (0x0a).

An example response to “A2x” is:
A,4,1,2,15,10,50,40,0
8.7 Continuous reporting commands

The Continuous reporting features are somewhat experimental. A description of each feature follows:

Table 8.27: Summary of standard commands

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporting enabled</td>
<td>Send a reading result every time it is available from internal computations. In bright settings, a reading will be made available once per second, around 14 mpsas, a reading will be available depending on the sensor response which is between 60+ times per second and 60 seconds in very dark settings.</td>
</tr>
<tr>
<td>Ideal crossover firmware</td>
<td>Changes the crossover of reporting from original (around 15 mpsas to 12.32 mpsas) which results in better resolution across the entire range of possible readings.</td>
</tr>
<tr>
<td>Reporting compressed</td>
<td>Send the above enabled reading out in a compressed format without extra text.</td>
</tr>
<tr>
<td>Report un-averaged</td>
<td>Sends the above reading out from the un-averaged accumulator. Normally the averaged reading is sent.</td>
</tr>
</tbody>
</table>

Table 8.28: Continuous reporting command summary

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yx</td>
<td>Get status of the continuous reporting features.</td>
</tr>
<tr>
<td>YRx</td>
<td>Enable continuous reporting.</td>
</tr>
<tr>
<td>Yrx</td>
<td>Disable continuous reporting.</td>
</tr>
<tr>
<td>YCx</td>
<td>Enable new crossover firmware code.</td>
</tr>
<tr>
<td>Ycx</td>
<td>Disable new crossover firmware code.</td>
</tr>
<tr>
<td>YPx</td>
<td>Enable continuous reporting compression.</td>
</tr>
<tr>
<td>Ypx</td>
<td>Disable continuous reporting compression.</td>
</tr>
<tr>
<td>YUx</td>
<td>Enable un-averaged continuous reporting.</td>
</tr>
<tr>
<td>Yux</td>
<td>Disable un-averaged continuous reporting.</td>
</tr>
</tbody>
</table>

Table 8.29: Response of all continuous reporting requests

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Y</td>
<td>Confirmation of command.</td>
</tr>
<tr>
<td>1</td>
<td>r</td>
<td>R = Continuous reporting enabled. r = Continuous reporting disabled.</td>
</tr>
<tr>
<td>2</td>
<td>C</td>
<td>C = Ideal crossover firmware code enabled. c = Ideal crossover firmware code disabled.</td>
</tr>
<tr>
<td>3</td>
<td>p</td>
<td>P = Continuous reporting compression enabled. p = Continuous reporting compression disabled.</td>
</tr>
<tr>
<td>4</td>
<td>u</td>
<td>U = Continuous reporting un-averaged readings enabled. u = Continuous reporting un-averaged readings disabled.</td>
</tr>
</tbody>
</table>

*Table continued on next page ...*
8 Commands and responses

Table 8.29 – continued from previous page

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5-6</td>
<td></td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
</tr>
</tbody>
</table>

An example response is:

```
YrCpu
01234
```


8.8 Setting Interval reporting parameters

For firmware feature ≥13, the SQM-LE is capable of sending timed interval reports. Each interval report is the same as the reading request report except that the serial number (feature ≥14) is attached at the end so that numerous reporting SQM-LEs can be distinguished from each other.

The format of the interval report is shown in table 8.30:

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>r</td>
<td>Indicates that a reading is being returned.</td>
</tr>
<tr>
<td>2-8</td>
<td>_06.70m</td>
<td>Reading in magnitudes per square arc second. Leading space for positive value. Leading negative sign (-) for negative value. A reading of 0.00m means that the light at the sensor has reached the upper brightness limit of the unit.</td>
</tr>
<tr>
<td>10-21</td>
<td>0000022921Hz</td>
<td>Frequency of sensor in Hz.</td>
</tr>
<tr>
<td>23-33</td>
<td>0000000020c</td>
<td>Period of sensor in counts. Counts occur at a rate of 460.8 kHz (14.7456MHz/32).</td>
</tr>
<tr>
<td>35-46</td>
<td>0000000.000s</td>
<td>Period of sensor in seconds with millisecond resolution. Determined by dividing the above counts value by 460800.</td>
</tr>
<tr>
<td>48-54</td>
<td>_039.4C</td>
<td>Temperature measured at light sensor in degrees C. The value is averaged and presented every 4.3 seconds. Leading space for positive value. Leading negative sign (-) for negative value.</td>
</tr>
<tr>
<td>55-63</td>
<td>00000413</td>
<td>Serial number (8 digits). Each unit has its own unique serial number.</td>
</tr>
<tr>
<td>64-65</td>
<td></td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
</tr>
</tbody>
</table>

An example is:
r, 06.70m,0000022921Hz,0000000020c,0000000.000s, 039.4C,00000413
0123456789 123456789 123456789 123456789 123456789 123456789

Interval reporting is available for sending timed reports to a listening server in the case where the SQM-LE IP address will not be known, but the server IP address will be fixed. One such application is where an SQM-LE is connected via a telephone/cell-phone based router to an Internet Service Provider. The server must have listening software running similar Listing: 8.1:

Listing 8.1: Listener script for interval based reports

```perl
#!/usr/bin/perl
use IO::Socket;
while(1){
    my $sock = new IO::Socket::INET (
        LocalHost => '192.168.1.163', #IP address of this computer/server
        LocalPort => '10002', #Port defined by XPort:Channel_1:Connection:Endpoint_Configuration:RemotePort
        Proto => 'tcp',
        Listen => 1,
        Reuse => 1,
    );
    die "Could_not_create_socket::$_" unless $sock;
```
8 Commands and responses

```c
my $new_sock = $sock->accept();
while($<new_sock>) {
    ($sec,$min,$hour,$mday,$mon,$year,$yday,$isdst)=localtime(time);
    printf "%04d-%02d-%02d,%02d:%02d:%02d,",
        $year+1900,$mon+1,$mday,$hour,$min,$sec;
    print $;
} close($sock);
}
```

To prevent reports being sent during daylight when the meter is saturated with light, a threshold value can be set. Readings exceeding the threshold (dark) will be reported, low readings (too bright) will be suppressed.

Due to the construction nature of EEPROM, there is a limited number of times that this memory can be written to before it becomes unreliable. In the case of the SQM-LE, the erase/write cycle is 1 million times. For this reason, it is recommended that frequent parameter changes be done in RAM rather than in EPROM. Only set the parameter to EEPROM when you want the unit to boot up with your setting. See following sections for how to set EEPROM or RAM.

Loading firmware clears resets the micro-controller effectively copying the EEPROM values into RAM.

Note: the above listener script is a simple receive only program. In a telephone mode system, the SQM-LE sends the response to the listener, and nothing can send requests back to the SQM-LE. So it is advised that all settings be tested before isolating the SQM-LE in remote locations. The other option to getting new requests back to the SQM-LE would be altering the listener script to queue requests during the short time that the SQM-LE connects back to the listener server.

8.8.1 Firewall settings at the listener side

The SQM-LE must be able to send interval reports directly to the listener script running on the listener server computer. If there is an internet firewall blocking the incoming packets on the listener server, then a port should be opened. If you are running the iptables on a Linux machine, here is an example when receiving from a machine at ip address 123.124.125.126 through port 10002:

Add the following rule to iptables:
```
iptables -A INPUT -p tcp -m tcp -s 123.124.125.126 --dport 10002 -j ACCEPT
```
and then run it to use the new rules.

8.8.2 XPort settings for interval reporting mode

The Ethernet adapter module (XPort) must be configured for sending interval based reports to a server. To set the SQM-LE to know the listener IP address use a web browser to access the SQM-LE, just type in the IP address of the SQM-LE into a web browser and you will be asked for a name and password, just hit enter (there is nothing set at default). You will be given a XPort configuration screen. You can also do the same things with the Lantronix Windows based “Device Installer” program included on the CD. Set the XPort as shown Table 8.31.

Note: The RemotePort is different than the typical 10001 to avoid problems with regular SQM-LE clients. Also, the RemoteHost is set to the IP address of your listener server.

<table>
<thead>
<tr>
<th>Channel 1: Connection:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Connection:ActiveConnect = &quot;With Any Character&quot;</td>
</tr>
<tr>
<td>Endpoint Configuration:RemotePort = 10002</td>
</tr>
<tr>
<td>Endpoint Configuration:RemoteHost = 192.168.1.145</td>
</tr>
<tr>
<td>Disconnect Mode:Inactivity Timeout: = 0:2(mins:secs)</td>
</tr>
</tbody>
</table>

If the modem takes a long time to connect then the timeout should be extended.

The Inactivity timeout should not exceed the interval time otherwise the unit may lock out other communications requests. If this occurs, you can recover by way of the Lantronix device installer or Lantronix web interface by typing the SQM-LE IP address into a web browser (hit enter on user name/password). Then set:
8.8 Setting Interval reporting parameters

Channel1:Connection:Disconnect-Mode:Inactivity-Timeout=0:2(mins:secs),
then press OK, then “Apply Settings”.
If the Inactivity timeout is too short, a telephone modem connection system may not have enough time to send the
message before the XPort gives up.
If the Inactivity timeout is too long, then a telephone modem connection may stay active all the time resulting in
excessive connection costs.

8.8.3 Interval reporting period setting

Executing the command “P##########x” (note upper case “P”) sets the period of the timed interval reports to the
EEPROM and RAM for booting and immediate use.
Executing the command “p##########x” (note lower case “p”) sets the period of the timed interval reports to RAM
only for immediate use.
The units are seconds. For example, the command “p0000000360x” sets the reporting time to once every 360 seconds.

8.8.4 Threshold setting for interval reporting

Executing the command “T########.##x” (note upper case “T”) sets the threshold of the timed interval reports to
EEPROM and RAM for boot and immediate use.
Executing the command “t########.##x” (note lower case “t”) sets the threshold of the timed interval reports to
RAM for immediate use only.
The units are \( \text{magnitudes arcsecond}^2 \). For example, \( t00000016.00x \) limits reporting to values only over 16.00 \( \text{magnitudes arcsecond}^2 \).

8.8.5 Interval setting response

Either making the request “Ix” (note upper case “I”) or any request to set the interval report setting produces the
following response shown in table 8.32:

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>I</td>
<td>Interval settings from EEPROM and RAM are being returned.</td>
</tr>
<tr>
<td>2-12</td>
<td>0000000360s</td>
<td>Interval period that was set into EEPROM.</td>
</tr>
<tr>
<td>14-24</td>
<td>00000300360s</td>
<td>Interval period that was set into RAM.</td>
</tr>
<tr>
<td>26-37</td>
<td>00000017.60m</td>
<td>Threshold value that was set into EEPROM.</td>
</tr>
<tr>
<td>39-50</td>
<td>00000017.60m</td>
<td>Threshold value that was set into RAM.</td>
</tr>
<tr>
<td>51-52</td>
<td></td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
</tr>
</tbody>
</table>

An example response is:

I,0000000360s,0000000360s,00000017.60m,00000017.60m
0123456789 123456789 123456789 123456789 123456789 12
8.9 Simulation commands

The following simulation commands help to determine the results of \( \frac{\text{mag}}{\text{arcsec}^2} \) readings derived from the light and temperature sensors.

When using the Simulation mode of the SQM-LE, make sure that nothing else interrupts the sequence of readings such as external programs reading from the SQM-LE, or settings of Interval reporting inside the SQM-LE.

To read the internal simulation values, issue the “sx” command, the response is shown in table 8.33:

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>s</td>
<td>Confirmation of the command.</td>
</tr>
<tr>
<td>1</td>
<td>,</td>
<td>Separation character.</td>
</tr>
<tr>
<td>2-12</td>
<td>0000000360c</td>
<td>Number of counts.</td>
</tr>
<tr>
<td>13</td>
<td>,</td>
<td>Separation character.</td>
</tr>
<tr>
<td>14-24</td>
<td>000000360f</td>
<td>Frequency in Hz.</td>
</tr>
<tr>
<td>25</td>
<td>,</td>
<td>Separation character.</td>
</tr>
<tr>
<td>26-37</td>
<td>000000244t</td>
<td>Temperature ADC value as seen by the CPU. See Equation 8.1.</td>
</tr>
<tr>
<td>38-39</td>
<td></td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
</tr>
</tbody>
</table>

An example response is:

s,000000360c,000000360f,000000360t
0123456789 123456789 123456789 12345678

To convert raw temperature value to degrees C:

\[
\text{DegC} = \frac{raw \times 3.3 - 0.5}{0.01}
\]  

(8.1)

To convert degrees C value to raw temperature:

\[
raw = \frac{(\text{DegC} \times 0.01 + 0.5) \times 1024}{3.3}
\]  

(8.2)

To set the internal simulation values and read the calculated response, issue the “S...x” command as detailed in Table 8.34. The result of that command is shown in Table 8.35.

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-1</td>
<td>s</td>
<td>Initiation of Sx command.</td>
</tr>
<tr>
<td>2-11</td>
<td>000000360</td>
<td>Simulated counts.</td>
</tr>
<tr>
<td>12</td>
<td>,</td>
<td>Separation character (can be anything except x).</td>
</tr>
<tr>
<td>13-22</td>
<td>000000360</td>
<td>Simulated Frequency in Hz</td>
</tr>
<tr>
<td>23</td>
<td>,</td>
<td>Separation character (can be anything except x).</td>
</tr>
</tbody>
</table>

Table continued on next page ...
### Table 8.34 – continued from previous page

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>24-33</td>
<td>00244</td>
<td>Simulated Temperature ADC value. See Equation 8.1.</td>
</tr>
<tr>
<td>34</td>
<td>x</td>
<td>Terminating character.</td>
</tr>
</tbody>
</table>

An example command is:

S,0000000360,0000000360,0000000360x
0123456789 123456789 123456789 1234

### Table 8.35: Response of setting simulation values (S...x)

<table>
<thead>
<tr>
<th>Column</th>
<th>Example value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-1</td>
<td>S,</td>
<td>Confirmation of S...x command.</td>
</tr>
<tr>
<td>2-13</td>
<td>0000094000c,</td>
<td>Simulated counts.</td>
</tr>
<tr>
<td>14-25</td>
<td>0000000000f,</td>
<td>Simulated frequency in Hz.</td>
</tr>
<tr>
<td>26-37</td>
<td>0000000245t,</td>
<td>Simulated temperature ADC value. See Equation 8.1.</td>
</tr>
<tr>
<td>38-39</td>
<td>r,</td>
<td>Beginning of calculated readings.</td>
</tr>
<tr>
<td>40-47</td>
<td>018.04m,</td>
<td>Calculated $\frac{\text{mag}}{\text{arcsec}^2}$.</td>
</tr>
<tr>
<td>48-60</td>
<td>0000000000Hz,</td>
<td>Frequency used for calculation.</td>
</tr>
<tr>
<td>61-72</td>
<td>0000094000c,</td>
<td>Counts used for calculation.</td>
</tr>
<tr>
<td>73-85</td>
<td>0000000.204s,</td>
<td>Calculated period from counts.</td>
</tr>
<tr>
<td>86-92</td>
<td>029.0C</td>
<td>Temperature used for calculation.</td>
</tr>
<tr>
<td>93-94</td>
<td>Carriage return (0x0d), Line feed (0x0a).</td>
<td></td>
</tr>
</tbody>
</table>

An example response is:

S,0000094000c,0000000000f,0000000245t,r,18.04m,0000000000Hz,0000000245t,r,0000000.204s,0000000.204s,029.0C
0123456789 123456789 123456789 123456789 123456789 123456789 123456789 123456789 123456789 123456789 123456789 1234
9 Installation

9.1 Electrical connection

An AC/DC adapter is provided. The SQM-LE uses a voltage regulator to bring the incoming DC voltage down to 3.3VDC. The lowest voltage at the input should be 4.5VDC (3.3 + 1.2VDC). Higher voltages above 6VDC will cause heating on the regulator and thermal shutdown in high ambient temperatures.

For remote applications, a deep-cycle (Lead Acid) 6VDC battery can be used.

The SQM-LE unit is NOT protected against over-voltage (above 20V) or reverse polarity voltage.

9.2 Mechanical installation

Unihedron sells an enclosure that is suitable for mounting either the SQM-LE, SQM-LU, SQM-LR, SQM-LU-DL into. You can read more about it, including plans to build your own at www.unihedron.com/projects/sqmhousing/.

Figure 9.1: Housing

9.2.1 Cover selection

If the unit is to be mounted in exposed location, we recommend the Unihedron plastic weatherproof housing with glass window plate, or an acrylic dome. Acrylic domes will last 2-3 years but eventually weather on the surface. It is not clear that this will affect the reading much. The best test would be to swap a weathered and new one back and forth when changing one out. Presumably the main consideration would be to keep the domes clean every so often and to make sure that the mounting plane is painted black to that it doesn’t reflect light back to the inside of the dome and then back into the meter.

Source of acryllic domes: www.globalplastics.ca/domes.htm

9.2.2 Cover calibration

Since the meter is not weather-proof, it must be protected in some way from the elements. The Unihedron meter housing or a plastic dome is recommended. This will reduce the incoming light (approximately 15-20%).

Because a covering will reduce the incoming light, the resultant reading will be darker (higher $\frac{mag}{arcsec^2}$ value). The offset determined by a simple light experiment should be subtracted from the reading.
Apply this subtraction offset as a negative value, i.e. if you measured 16.60 outside the covering, then 16.75 under the dome, then an offset of -0.15 should be applied to all readings.

An example using the UDM software; if your offset is -0.15 and your factory calibrated light calibration offset is 19.92 then you should change the light-calibration-offset on the calibration-tab to 19.77. European users will see and use a comma instead of a decimal point (eg. 19,77).

**Figure 9.2: Example cover calibration**

### 9.2.3 Cover maintenance

Keep the covering clean of dust, water, ice, and bird droppings.
Chapter 10 Default settings

10.1 XPort settings

The XPort Ethernet interface has been programmed with the following default settings so that it can communicate with the SQM-LE micro-controller:

<table>
<thead>
<tr>
<th>Setting description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configurable pins, CP2:</td>
<td>HW Flow Control In (CTS from microcontroller)</td>
</tr>
<tr>
<td>Channel 1, Serial Settings, Baud rate:</td>
<td>115200</td>
</tr>
<tr>
<td>Channel 1, Serial Settings, Flow control:</td>
<td>CTS/RTS Hardware</td>
</tr>
</tbody>
</table>

Table 10.1: Default XPort settings

If for some reason these settings are altered, they can be restored using the Lantronix Device Installer under Windows. Or the UDM program (select Firmware, XPort defaults).

10.2 ARP method

Use the arp method to reset the Xport Ethernet module back to DHCP from a fixed IP address.

The arp method is superior to the LDI method as the arp method will find devices that the LDI cannot find and have had their IP addresses assigned away from DHCP. Some extra arp method details from the XPort manufacturer are defined in the document, Xport-arp-method.pdf, on USB drive in the directory:

/SQM-LE/reference/

You must first assign a temporary IP address on your system (shown as yyy below), pick an free intended address that is in your network subdomain, and example for yyy might be 192.168.1.109

For Windows

1. Open an admin command prompt in Windows, Start–Programs–Accessories, then right click on the Command prompt program and select “run as administrator”

2. To find the IP address of your Windows computer, use the ipconfig command.

3. In a Windows command prompt, create an entry in the host’s ARP table using the intended IP address and the hardware address of the unit (on the product label on the bottom of the unit) as follows:
   ```
   arp -s yyy 00-20-4a-xx-xx-xx
   ```

4. Open a Telnet connection to port 1. The connection fails quickly, but the unit temporarily changes its IP address to the one designated in this step:
   ```
   telnet yyy 1
   ```
5. Open a Telnet connection to port 9999, and press Enter within five seconds to go into Setup Mode. If you wait longer than five seconds, the unit reboots:
   telnet yyy 9999

6. Select 0 (Server Configuration) and follow the prompts until you get to IP address.

7. Enter the new IP address, subnet mask, and gateway (if applicable).

8. Select 9 to save and exit Setup Mode. The unit performs a power reset.

10.2.1 For Linux

1. Open a superuser command prompt in Linux.

2. To find the IP address of your computer, use the `ifconfig` command.

3. In the command prompt, create an entry in the host’s ARP table using the intended IP address and the hardware address of the unit (on the product label on the bottom of the unit) as follows:
   ```
   arp -s yyy 00-20:4a:xx:xx:xx
   ```

4. Open a Telnet connection to port 1. The connection fails quickly, but the unit temporarily changes its IP address to the one designated in this step:
   ```
   telnet yyy 1
   ```

5. Open a Telnet connection to port 9999, and press Enter within five seconds to go into Setup Mode. If you wait longer than five seconds, the unit reboots:
   ```
   telnet yyy 9999
   ```

6. Select 0 (Server Configuration) and follow the prompts until you get to IP address.

7. Enter the new IP address, subnet mask, and gateway (if applicable).

8. Select 9 to save and exit Setup Mode. The unit performs a power reset.
11 Firmware upgrade

See the UDM “Firmware tab” section on page 54 for instructions on updating the firmware in the SQM-LE.

11.1 Details

The SQM-LE contains a micro-controller that is equipped with a boot-loader mechanism which is enabled for a few seconds after reboot/reset. Intel hex strings sent to the unit are used to overwrite program memory. The following link contains a thorough description of the Intel Hex format: [http://en.wikipedia.org/wiki/.hex](http://en.wikipedia.org/wiki/.hex)

The basic requirements for firmware uploading are:

1. Reset micro-controller by sending the hex character 0x19
2. Within a few seconds, send the first Intel hex record. The colon “;” character indicates the beginning of an Intel Hex record.
3. Wait for a response of “Ok” followed by “CR LF” which indicates that the record was processed properly.
4. Continue sending records and waiting for the acknowledgement.
5. The unit will reset on its own when no more records have been sent for a few seconds.
12 Calibration

The SQM-LE is factory calibrated and a sheet of the calibration values was provided with the unit. Contact Unihedron with your unit’s MAC address if you need a copy of the original calibration sheet.

Some possible reasons for recalibration are:

1. A new covering/housing is being used besides the small case that the unit was shipped with.
2. A regular maintenance program is desired. There is no great need for this as the SQM-LE has no analog components.
3. Compensation for aged housing, if a plastic dome is used that might have degraded over time.
4. Replaced lens or changed field of view for experimental reasons.

12.1 Recalibration

There is no easy way to perform in-field recalibration. It is recommended to send the unit back to Unihedron for proper calibration. There is a nominal fee for recalibration and shipping. Please contact Unihedron for details.

12.2 Light calibration

The sensor must have a reference point for an amount of light against the signal produced. It is not recommended that this be done after factory calibration and relied upon since an improper setup will result in non-standard results.

A fluorescent light or green LED is used to simulate the spectrum that the meter would see during the night sky. A light meter is used to adjust the light reading to 13.5 fc at the place of the SQM-LE. The light calibration routine inside the SQM-LE expects to see this value.

The light that the SQM-LE and light meter see must be coming from an evenly lit surface.

The “light calibration” command can be sent to the unlocked SQM-LE to set the calibration value.

12.3 Dark calibration

The optical sensor in the SQM-LE produces a reading even when totally dark. This “dark level” reading must be determined so that the meter can compensate for it.

The method of dark calibration is simply to prevent any light from entering the meter then execute a “dark calibration” command to the unit. A darkroom bag is one way to prevent light from entering the unit.

The optical sensor provides timed pulses depending on the amount of light entering. In a dark environment the pulses will be long. The meter has a timeout of 300 seconds, so the dark calibration will take at least 5 minutes (300 seconds) to perform.

Place the unit in a dark environment and monitor the timed readings (rx reading request) until they are consistent, normally the value is in the 80-300 second range, then execute the “dark calibration” command.

12.4 Confirmation

Once the calibration has been done, you should be able to get a light reading from the unit at the calibration light level of the same value as the value printed on your calibration sheet in the “Calibration offset” field, Normally this field has a value of 8.71 mags/arcsec².
### 13 Troubleshooting

#### Table 13.1: Reading seem too bright

<table>
<thead>
<tr>
<th>Problem</th>
<th>The meter reads values that are brighter than expected.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>A light may be shining into the field of view of the meter.</td>
</tr>
<tr>
<td></td>
<td>Or, the IR filter may have fallen out of the lens.</td>
</tr>
<tr>
<td>Solution</td>
<td>Ensure that there are no extra sources of visible light in the field of view of the meter. Also, some infrared security cameras emit enough light in the spectrum that the meter will pick up.</td>
</tr>
<tr>
<td></td>
<td>Inspect lens for IR filter. You should see a light blue colour inside the lens.</td>
</tr>
</tbody>
</table>

#### Table 13.2: Reading is 0.00mpsas

<table>
<thead>
<tr>
<th>Problem</th>
<th>The meter reads values of 0mpsas.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>In bright light over about 6mpsas (even indoors) the meter saturates and will produce a reading of 0mpsas.</td>
</tr>
<tr>
<td>Solution</td>
<td>Test the meter in a darker setting or place a cover over the meter while doing indoor testing. Note: in complete darkness (like a photo-darkroom), the meter may timeout and also produce strange readings.</td>
</tr>
</tbody>
</table>

#### Table 13.3: Cannot Find UDM software

<table>
<thead>
<tr>
<th>Problem</th>
<th>Microsoft Edge cannot find UDM software on the CD. Error “Can’t reach this page”.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>Microsoft Edge has protections in place to hide file lists on remote drives.</td>
</tr>
<tr>
<td>Solution</td>
<td>Use the File Manager to navigate the CD to the Windows directory then install from there. Or, get the latest Windows version of UDM from the Unihedron website: unihedron.com/projects/darksky/cd/Windows/</td>
</tr>
</tbody>
</table>

#### Table 13.4: Meter seems too hot

<table>
<thead>
<tr>
<th>Problem</th>
<th>The reported temperature seems to be too hot.</th>
</tr>
</thead>
</table>

*Table continued on next page ...*
Table 13.4 – continued from previous page

| Cause | The SQM-LE contains a webserver (XPort Ethernet module) requires a great deal of power which raises the internal above ambient by 20-30°C. This is not really a problem because the SQM-LE is rated for a very high temperature (85°C), and the light sensor readings are compensated for temperature. The maximum operating temperature of all the components inside the SQM-LE is 85°C. We have been operating the unit inside a housing and the unit temperature has reached 65°C on many occasions without affecting operation. The light sensor readings are compensated for temperature fluctuations. The temperature sensor located very close to the light sensor. |
| Solution | No action is required. |

Table 13.5: Readings do not get dark enough

| Problem | The reported reading does not seem to get dark enough. |
| Cause | Ensure that man-made light is not entering the lens. Some people have thought that the LEDs from the PoE may be entering into the lens by way of reflections inside the weatherproof housing. We have not been able to prove this with testing ourselves. |
| Solution | Make sure that the PoE LEDs are facing towards the bottom of the weatherproof housing. You can also try to use black tape to cover the LEDs. |

Table 13.6: Error 404 when trying to reconfigure Ethernet module

| Problem | Error 404 when trying to reconfigure Ethernet port using the web interface |
| Cause | The interface pages may have been overwritten by a “tftp put” to the wrong remotefile. The default XPort Ethernet reconfiguration web interface occupies at least 3 blocks of 64k (WEB1-WEB4). WEB5-6 could be used for custom application pages (like test.html) which take up to 128K. |
| Solution | Get the web interface from Lantronix for the XPort-03, then install using the following tftp command: for Windows: \texttt{tftp-i <ip adress> put xpt\_webm\_1602\_cob WEB1} for Linux (using tftp-hpa): \texttt{tftp < ip adress > -m binary -c put xpt\_webm\_1602\_cob WEB1} |

Table 13.7: Meter will not respond

| Problem | Unit will not respond to ping or any network activity. |
| Cause | Ethernet interface did not properly negotiate an IP address when starting up. |

Table continued on next page ...
Table 13.7 – continued from previous page

<table>
<thead>
<tr>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power check:</td>
</tr>
<tr>
<td>Check connection lights on SQM-LE Ethernet port. No lights after power up could indicate a faulty power connection.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Network check:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Re-cycle power on SQM-LE so that its Ethernet port can re-negotiate an IP address.</td>
</tr>
<tr>
<td>2. Use the Lantronix Device Installer program for Windows (supplied on the USB stick in the directory: /SQM-LE/windows/). This will identify all SQM-LE units on the attached network.</td>
</tr>
<tr>
<td>3. It is possible that a firewall may be running, especially on Windows Vista. Try shutting off the firewall temporarily.</td>
</tr>
<tr>
<td>4. Use the red crossover cable (supplied) to connect the SQM-LE directly to the computer then retry the Lantronix Device Installer.</td>
</tr>
</tbody>
</table>

To reset the Xport module back to DHCP, see the ARP method on page 86.

Table 13.8: Socket error 10051

<table>
<thead>
<tr>
<th>Problem</th>
<th>Windows reports “Socket error #10051”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>The network is unreachable. Which means that the device likely works properly, but for some reason (like domain restrictions) the router or network settings do not allow communication to that device.</td>
</tr>
<tr>
<td>Solution</td>
<td>Use the arp technique described in Table 13.7 to set the IP address to a free address in your network.</td>
</tr>
</tbody>
</table>

Table 13.9: Ping but no readings

<table>
<thead>
<tr>
<th>Problem</th>
<th>Unit can be pinged but readings are not returned.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>The default communication settings between the XPort micro-controller may have been changed.</td>
</tr>
<tr>
<td>Solution</td>
<td>Use the Unihedron Device Manager (supplied software), select the Firmware tab, then press the XPort defaults button. This will set the Ethernet module parameters like those defined in section 8 (Default settings) for proper baud rate, etc.</td>
</tr>
</tbody>
</table>

Table 13.10: Ping but cannot be found by UDM

<table>
<thead>
<tr>
<th>Problem</th>
<th>Unit can be pinged, but UDM cannot find it.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>UDM requires that port 30718 is open for discovery of the SQM-LE.</td>
</tr>
<tr>
<td>Solution</td>
<td>Enable port 30718 in your firewall or router.</td>
</tr>
</tbody>
</table>

Table 13.11: Lantronix Device Installer update problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Lantronix Device Installer does not show updates.</th>
</tr>
</thead>
</table>

Table continued on next page ...
Table 13.11 – continued from previous page

<table>
<thead>
<tr>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The browser feature of the “Lantronix Device Installer” appears to be not as capable as modern web browsers.</td>
<td>Making changes to your SQM-LE Xport Ethernet module can be done by directly accessing it with a web browser. Go to the URL of the IP address of your browser, no username or password are required, just hit enter when asked.</td>
</tr>
</tbody>
</table>

Table 13.12: Reading errors reported

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQM-Reader version 1.2 and earlier while reports reading errors while UDM correctly reports text strings.</td>
<td>Regional settings in Windows may be set for the European standard for decimal separators as commas “,” instead of periods “.”</td>
<td>Upgrade to a newer version of SQM-Reader by Knightware or modify your regional settings to use periods as the decimal point separators.</td>
</tr>
</tbody>
</table>

Table 13.13: Darkroom-bag readings incorrect

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meter readings from inside a darkroom-bag are not dark enough or do not change.</td>
<td>In completely dark environments, the meter cannot collect enough light to even resolve one reading.</td>
<td>Test the meter in natural darkness outside at night.</td>
</tr>
</tbody>
</table>
## 14 Glossary

Table 14.1: Glossary of terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADC</td>
<td><strong>Analog to Digital Converter.</strong> A device used to convert an analog signal into a digital value.</td>
</tr>
<tr>
<td>CCD</td>
<td><strong>Charge coupled device</strong> is a type of image sensor.</td>
</tr>
<tr>
<td>DHCP</td>
<td><strong>Dynamic Host Configuration Protocol (DHCP)</strong> is a network application protocol used by devices (<strong>DHCP clients</strong>) to obtain configuration information for operation in an IP network. Routers equipped with DHCP are capable of assigning an IP address to the SQM-LE.</td>
</tr>
<tr>
<td>EEPROM</td>
<td><strong>Electrically Erasable Programmable Read Only Memory</strong> is a type of memory that retains its contents after the power has been removed. This type of memory has a limited write/erase cycle as well as a lifetime for data retention. In the SQM-LE, the parameters in the micro-controller can be written 1 million times and last for 100 years.</td>
</tr>
<tr>
<td>Firmware</td>
<td>The program that resides inside the device. In the case of the Unihedron SQM products, it is the software runs the device including reading and reporting the light values.</td>
</tr>
<tr>
<td>FITS</td>
<td><strong>Flexible Image Transport System</strong> is an open standard defining a digital file format useful for storage, transmission and processing of scientific and other images.</td>
</tr>
<tr>
<td>GPS</td>
<td><strong>Global Positioning System.</strong> A GPS receiver may be connected to a computer to allow UDM to integrate the location information into the logged data. See UDM for model details.</td>
</tr>
<tr>
<td>mpsas</td>
<td><strong>Magnitudes per square arcsecond.</strong> The unit of measurement reported by the SQM.</td>
</tr>
<tr>
<td>NMEA</td>
<td><strong>National Marine Electronics Association</strong> data format that the GPS receiver produces.</td>
</tr>
<tr>
<td>SQM-LE</td>
<td><strong>Sky Quality Meter</strong> with lens and Ethernet connectivity.</td>
</tr>
<tr>
<td>IP address</td>
<td><strong>Internet Protocol</strong> address is the numerical identification of a device on a network. The SQM-LE, by default, has an assignable IP address, but can also be set to have a fixed IP address.</td>
</tr>
<tr>
<td>MAC address</td>
<td><strong>Media Access Control</strong> address is the hardware address assigned to Ethernet enabled devices. This address is usually unchangeable.</td>
</tr>
<tr>
<td>PoE</td>
<td><strong>Power over Ethernet</strong> is a system used to inject power into an Ethernet cable which can be split out for powering devices.</td>
</tr>
<tr>
<td>RAM</td>
<td><strong>Random Access Memory.</strong> Temporary memory that only retains data while power is applied.</td>
</tr>
<tr>
<td>SQM-LE</td>
<td><strong>Sky Quality Meter with Lens and Ethernet connectivity</strong></td>
</tr>
<tr>
<td>UDM</td>
<td><strong>Unihedron Device Manager</strong> is software used to access the SQM series of meters.</td>
</tr>
<tr>
<td>XPort</td>
<td>Lantronix Ethernet module. The SQM-LE contains this XPort module to link the SQM-LE’s internal microcontroller to the Ethernet port.</td>
</tr>
</tbody>
</table>
15 Bibliography


